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1

Introduction

The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence
and Security Act of 2007 (EISA), requires the National Highway Traffic Safety
Administration (NHTSA), an agency within the U.S. Department of Transportation (DOT),
to promulgate and enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA
has been administering these standards since 1975.
The Volpe National Transportation Systems Center (Volpe Center) provided technical
support to the Department in connection with the establishment of the CAFE program in
the 1970s, and has continued to provide such support since that time. The Volpe Center is a
federal fee-for-service organization within DOT's Research and Innovative Technology
Administration (RITA).
In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s
analysis of options for future CAFE standards. Objectives included, but were not limited to,
the following: the ability to utilize detailed projections of light vehicle fleets to be produced
for sale in the United States, the ability to efficiently estimate how manufacturers could
apply available technologies in response to CAFE standards, the ability to quickly evaluate
various options for future CAFE standards, and the ability to estimate a range of outcomes
(in particular, changes in fuel consumption and emissions) resulting from such standards.
Since 2002, the Volpe Center has made many changes to this modeling system. Some
changes were made in response to comments submitted to NHTSA in connection with
CAFE rulemakings, and in response to a formal peer review of the system. Some changes
were made based on observations by NHTSA and Volpe Center technical staff. As NHTSA
began evaluating attribute-based CAFE standards (i.e., standards under which CAFE
requirements depend on the mix of vehicles produced for U.S. sale), significant changes
were made to enable evaluation of such standards. At the same time, the system was
expanded to provide the ability to perform uncertainty analysis by randomly varying many
inputs. Later, the system was further expanded to provide automated statistical calibration
of attribute-based standards, implementation of Monte Carlo techniques (for evaluating the
uncertainty of model results), as well as automated estimation of stringency levels that
meet specified characteristics (such as maximizing estimated net benefits to society). In
2007, NHTSA and Volpe Center staff worked with technical staff of the U.S. Environmental
Protection Agency (EPA) on major changes to the range of fuel-saving technologies
accommodated by the model, as well as the logical pathways for applying such technologies.
In 2008, NHTSA and Volpe Center staff collaborated on further revisions, particularly with
respect to the representation of available fuel-saving technologies, support for the
reexamination of which was provided by Ricardo, Inc.

2 System Design
2.1 Overall Structure
The basic design of the CAFE Compliance and Effects Modeling System developed by the
Volpe Center is as follows: The system first estimates how manufacturers might respond to
a given CAFE scenario, and from that the system estimates what impact that response will
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have on fuel consumption, emissions, and economic externalities. A CAFE scenario involves
specification of the form, or shape, of the standards (e.g., flat standards, linear or logistic
attribute-based standards, scope of passenger and nonpassenger regulatory classes), and
stringency of the CAFE standard in each model year to be analyzed.
Manufacturer compliance simulation and effects estimation encompass numerous
subsidiary elements. Compliance simulation begins with a detailed initial forecast of the
vehicle models offered for sale during the simulation period. The compliance simulation
then attempts to bring each manufacturer into compliance with a CAFE policy scenario
described in an input file developed by the user. The model sequentially applies various
technologies to different vehicle models in each manufacturer’s product line in order to
simulate how a manufacturer might make progress toward compliance with CAFE
standards. Subject to a variety of user-controlled constraints, the model applies
technologies based on their relative cost-effectiveness, as determined by several input
assumptions regarding the cost and effectiveness of each technology, the cost of CAFErelated civil penalties, and the value of avoided fuel expenses. For a given manufacturer,
the compliance simulation algorithm applies technologies either until the manufacturer
achieves compliance, or until the manufacturer exhausts all available technologies, or, if
the manufacturer is assumed to be willing to pay civil penalties, until paying fines becomes
more cost-effective than increasing vehicle fuel economy. The user may disable the fine
paying option for manufacturers that generally do not pay fines, thus effectively “forcing”
the manufacturer to add additional technology even though it is not cost effective (from the
manufacturer’s perspective) to do so. At this stage, the system assigns an incurred
technology cost and updated fuel economy to each vehicle model, as well as any civil
penalties incurred by each manufacturer.
This point marks the system’s transition between compliance simulation and effects
calculations. At the conclusion of the compliance simulation for a given model year, the
system contains a new fleet of vehicles with new prices, fuel types (gasoline, diesel), fuel
economy values, and curb weights that have all been updated to reflect the application of
technologies in response to CAFE requirements. For each vehicle model in this fleet, the
system then estimates the following: lifetime travel, fuel consumption, and carbon dioxide
and criteria pollutant emissions. After aggregating model-specific results, the system
estimates the magnitude of various economic externalities related to vehicular travel (e.g.,
noise) and energy consumption (e.g., the economic costs of short-term increases in
petroleum prices).
Different categorization schemes are relevant to different types of effects. For example,
while a fully disaggregated fleet is retained for purposes of compliance simulation, vehicles
are grouped by type of fuel for the energy and carbon dioxide calculations, and by U.S.
Environmental Protection Agency (EPA) emissions classes for criteria pollutant
calculations. The system may be expanded in the future to represent CAFE-induced market
responses (i.e., mix shifting), in which case such calculations would group vehicles by
market segment.
Therefore, this system uses model-by-model categorization and
accounting when calculating most effects, and aggregates results only as required for
efficient reporting.
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2.2

CAFE Compliance Simulation

2.2.1

Compliance Simulation Algorithm

Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of
these scenarios is defined in the “scenarios” input file described in Appendix C. Each
scenario describes an overall CAFE program in terms of the program’s coverage, the
definition of nonpassenger automobiles, the structure and stringency of the standards
applicable to passenger and nonpassenger automobiles. The system is normally used to
examine and compare at least two scenarios. The first scenario is identified as the baseline
scenario, providing results to which results for any other scenarios are compared. Although
many scenarios can be examined with each run of the model, for simplicity in this overview,
we will only describe one scenario occurring in one model year.
The compliance simulation applies technology to each manufacturer’s product line based on
the CAFE program described by the current scenario and the assumed willingness of each
manufacturer to pay civil penalties rather than complying with the program. The first step
in this process involves definition of the fleet’s initial state—that is, the volumes, prices,
and attributes of all vehicles as projected without knowledge of future CAFE standards—
during the study period, which can cover one or more consecutive model years (MYs). The
second step involves evaluating the applicability of each available technology to each
vehicle model, engine, and transmission in the fleet. The third and final step involves the
repeated application of technologies to specific vehicle models, engines, and transmissions
in each manufacturer’s fleet. For a given manufacturer, this step terminates when CAFE
standards have been achieved or all available technologies have been exhausted.
Alternatively, if the user specifies that some or all manufacturers should be considered
willing to pay CAFE fines (i.e., civil penalties for noncompliance), this step terminates
when it would be less expensive to pay such fines than to continue applying technology.
2.2.1.1

Initial State of the Fleet

The fleet’s initial state is developed using information contained in the vehicle models,
engine, and transmission worksheets described in Appendix C. The set of worksheets uses
identification codes to link vehicle models to appropriate engines, transmissions, and
preceding vehicle models. Figure 1 provides a simplified example illustrating the basic
structure and interrelationship of these three worksheets, focusing primarily on
structurally important inputs. These identification codes make it possible to account for the
use of specific engines or transmissions across multiple vehicle models. They also help the
compliance simulation algorithm to appropriately “carry over” technologies between model
years.
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Vehicle Models Worksheet
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Transmissions Worksheet
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State
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2.2.2

Vehicle Technology Application within the CAFE Model

Vehicle technologies are a set of possible improvements available for the vehicle fleet. The
vehicle technologies, referred to below simply as ‘technologies’, are defined in the
technology input file for the model (see Appendix D.4). As a part of the definition for each
technology there is an associated cost for the technology, an improvement factor (in terms of
percent reduction of fuel consumption), the introduction year for the technology, whether it
is applicable to a given class of vehicle, grouping (by technology group – engine,
transmission, etc.) and phase-in parameters (the amount of fleet penetration allowed in a
given year). Also defined in the technology inputs file are cost synergies and improvement
synergies.
Having defined the fleet’s initial state, the system applies technologies to each
manufacturer’s fleet based on the CAFE program for the current model year. The set of
technologies accommodated by the model is discussed in NHTSA’s 2009 Final Rule (FR)
regarding CAFE standards for passenger cars and light trucks produced for sale in the
United States in model years 2011.1
As discussed in the FR, the set of technologies, and the methods for considering their
application, builds on a 2002 study by the National Academy of Sciences.2 That study
estimated that the applicability of different technologies would vary based on vehicle type.
Although the model now represents a wider range of technologies than the 2002 NAS study,
and uses different logical sequences for considering their addition to manufacturers’ fleets,
the model retains the ability for differentiation based on vehicle type. NAS is currently
conducting a study to develop an updated assessment of fuel-saving technologies.
2.2.2.1

Vehicle Technology Class

The CAFE model uses twelve technology classes as shown in Table 1:
Table 1. CAFE Technology Vehicle Classes
Class
Subcompact PC
Subcompact Perf.
Compact PC
Compact Perf
Midsize PC
Midsize Perf
Large PC
Large Perf

Description
Subcompact passenger car.
Subcompact performance oriented passenger car
Compact passenger car
Compact performance oriented passenger car
Midsized passenger car
Midsized performance oriented passenger car
Large passenger car
Large performance oriented passenger car

1

Federal Register / Vol. 74, No. 59 / Monday, March 30, 2009 / Rules and Regulations, pp. 14233-14308. Available
on the internet at http://www.gpoaccess.gov/fr/.
2

National Research Council, ‘‘Effectiveness and Impact of Corporate Average Fuel Economy (CAFE) Standards,’’
National Academy Press, Washington, DC (2002). Available at
http://www.nap.edu/openbook.php?isbn=0309076013 (last accessed April 20, 2008). The conference committee
report for the Department of Transportation and Related Agencies Appropriations Act for FY 2001 (Pub. L. 106–
346) directed NHTSA to fund a study by NAS to evaluate the effectiveness and impacts of CAFE standards (H. Rep.
No. 106–940, p. 117–118). In response to the direction from Congress, NAS published this report.
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Class
Small LT
Midsize LT
Large LT
Minivan

2.2.2.2

Description
Small sport utility vehicles and pickups
Midsize sport utility vehicles and pickups
Large sport utility vehicles and pickups
Minivans

Technology Groups:

The CAFE Model organizes technologies into groups. The table below lists the technologies
represented by the system, and the grouping we have applied to enable the system to follow
a logical incremental path within any given group without being unnecessarily prevented
from considering technologies in other groups. This “parallel path” approach is discussed
below.
Table 2. Technology Group Assignments
Technology Group

Engine Technology Group
(EngMod)

Electrical Accessory Group
(ELEC)

Transmission Technology Group
(TrMod)
Material Substitution Technology
Group (MSM)
3

Group Members
Low Friction Lubricants (LUB)
Engine Friction Reduction (EFR)
Variable Valve Timing type
 VVT Coupled Cam Phasing on SOHC (CCPS)
 VVT Couple Cam Phasing on OHV (CCPO)
 VVT Intake Cam Phasing (ICP)
 VVT Dual Cam Phasing (DCP)
Cylinder Deactivation
 on SOHC (DEACS)
 on DOHC (DEACD)
 on OHV (DEACO)
Variable Value Lift & Timing
 Discrete Variable Valve Lift [DVVL] on SOHC (DVVLS)
 Discrete Variable Valve Lift [DVVL] on DOHC (DVVLD)
 Continuously Variable Valve Lift (CVVL)
 Discrete Variable Valve Lift [DVVL] on OHV (DVVLO)
 Continuously Variable Valve Lift (CVVL)
Conversion to DOHC with DCP (CDOHC)
Stoichiometric Gasoline Direct Injection (SGDI)
Combustion Restart (CBRST)
Turbocharging and Downsizing (TRBDS)
Exhaust Gas Recirculation [EGR] Boost (EGRB)
Dieselization3 (DSLC, DSLT)
Electric Power Steering (EPS)
Improved Accessories (IACC)
12 Volt Micro-Hybrid (MHEV)
Higher Voltage/Improved Alternator (HVIA)
Belt Mounted Integrated Starter Generator (BISG)
6-Speed Manual/Improved Internals (6MAN)
Improved Auto. Transmission Controls/Externals (IATC)
Continuously Variable Transmission (CVT)
6/7/8 Speed Transmission With Improved Internals (NAUTO)
Dual Clutch or Automated Manual Transmission (DCTAM)
Material Substitution 1% (MS1)
Material Substitution 2% (MS2)

Replacing a gasoline engine with a diesel engine.
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Technology Group

Hybrid Technology Group (HEV)
Dynamic Load Reduction
Technology Group (DLR)
Aerodynamic Reduction
Technology Group (AERO)

Group Members
Material Substitution 5% (MS5)
Power Split Hybrid (PSHEV)
2-Mode Hybrid (2MHEV)
Plug-in Hybrid (PHEV)
Low Rolling Resistance Tires (ROLL)
Low Drag Brakes (LDB)
Secondary Axle Disconnect (SAXL)
Aerodynamic Drag Reduction (AERO)

As shown in Appendix D.4, input estimates for each of these technologies are specified in
the technologies input file, and are specific to each of the CAFE technology vehicle classes,
as shown in Table 1. The following table lists the input assumptions specified in this file.
Input
FC-Lower
FC-Upper
Cost-Lower
Cost-Upper
Learning Type
Threshold
Learning Rate
Year Available
Applicability
Phase-In
Aux.
Abbr.
TechType

Table 3. Technology Input Assumptions
Definition
minimum reduction (%) of fuel consumption
maximum reduction (%) of fuel consumption
minimum added cost4 (retail price equivalent in 2007 dollars)
maximum added cost (retail price equivalent in 2007 dollars)
Indicates whether the learning type is based on time or volume (or
neither)
For technology costs derived through learning curves, this parameter
is used as the threshold volume learning curve cost calculations
For technology cost derived through learning curves, this parameter is
used as the rate of decline in learning curve cost calculations.
first model year the technology is available
Whether the technology is available for the given vehicle class or not.
Set of percentages showing the phase-in limit at each model year.
Used to specify cost basis. If present, identifies whether technology
costs are calculated on a per-cylinder, per-engine-bank, or per-pound
removed basis.
abbreviation for technology
technology group (see technology group (see Table 2))

The technology input assumptions define applicability, cost, fuel consumption reduction
factors, and define which technology group of which the technology is a member.
2.2.2.3

Technology Applicability

The technology input assumptions have two means of defining technology applicability. One
means is with the Applicability field. If the field is set to “TRUE”, then the technology is
available for the particular class of vehicle, otherwise, the technology is unavailable.

4

Because materials substitution is applied as a percentage of curb weight, the corresponding cost estimates are in
dollars per pound of incremental change in curb weight.
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The other applicability control in the input assumptions is the year available field. If the
year being modeled by the CAFE Model is prior to the setting in the year available field,
then the technology will be unavailable for the particular class of vehicle.
Besides those mentioned, there are also other technology applicability factors within the
CAFE Model. For example, there are controls for individual vehicles in the market data file
that can override the controls here (see Appendix C). There are also dynamic considerations
made while the model is running based on vehicle configuration (e.g. material substitution
technology only applies to vehicles over 5,000 pounds curb weight), as well as technology
combination factors (e.g.,. DVVLD is incompatible with CVVL).
2.2.2.4

Technology Fuel Consumption Reduction Factors

The technology input assumptions—specified in an input file supplied by the
the fuel consumption reduction factors FC_Lower and FC_Upper as a range of
and high estimate. By default, the CAFE Model uses the average of the
running the model, the user can direct the model to apply low or high fuel
reduction factors.

user—define
low estimate
two. When
consumption

The reduction in fuel consumption values are on a gallons-per-mile basis and represent a
percent reduction in fuel consumption. The formula to find the increase in fuel economy
(miles-per-gallon) of a vehicle with fuel consumption reduction factors from one or more
technologies, is:

FEnew  FEorig 

1
1
1


1  FCReduction0  1  FCReduction1  1  FCReductionn 

(1)

where FEorig is the original fuel economy for the vehicle and FCnReduction0,1,…n are the fuel
consumption reduction factors.
2.2.2.5

Technology Synergies

Technology synergies exist when the combination of two technologies yields a fuel
consumption reduction which differs from what would be derived directly from equation ( 1
) above. The synergy can be positive (increased reduction of fuel consumption) or negative
(decreased reduction of fuel consumption). Synergy relationships within a technology group
are accounted for within the fuel consumption reduction factors for the technologies within
that group.
Synergy relationships between technology groups are captured in the Synergies table in the
technology input file. The system reads the information from the table and, for each
technology, stores the synergy factors between that technology and all other technologies.
For cases where there is no synergy relationship, there will be no listing in the table, and
the synergy factor will be zero (0.0). In cases where there are synergies, that factor is added
to the fuel consumption reduction value. Although negative synergies lessen the fuel
consumption reductions of a technology, the system assumes technologies will not combine
to degrade fuel economy (i.e., to produce negative reductions in fuel consumption).
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The layout of the synergy table in the technology input file is discussed in Appendix C.
2.2.2.6

Technology Cost

The technology input assumptions—specified in an input file supplied by the user—define
technology costs Cost_Lower and Cost_Higher as a range of low estimate and high
estimate. By default, the CAFE Model uses the average of the two. When running the
model, the user can direct the model to apply low or high costs.
Some technology costs have a cost basis associated with them. For instance, for material
substitution technologies, the technology input costs must be multiplied by the reduction of
vehicle curb weight, in pounds, to get the full cost of applying the technology. Similarly
some engine technologies have costs determined on a per cylinder or per bank
(configuration) basis. The model uses the ‘Aux’ column to identify when technologies have
an underlying cost basis associated with them, as discussed further in NHTSA’s 2009 Final
Rule.
Several other technologies involve ‘learning’. Learning is a means of capturing the
reduction in cost of components and manufacturing process involved with a technology
which takes place as the volume of deployment of that technology increases dramatically, or
due to other factors, such as negotiated contractual agreements between suppliers and
OEMs, which occur over a period of time. The model recognizes these two types of learning,
volume-based and-time based. If a technology’s cost assumption is based on learning, the
LearningType field (Table 3) will indicate which type. The formula used for learning cost
based on volume is shown in equation ( 2 ), the formula used for learning cost based on time
is shown in equation ( 3 ).
i t

kD  2;cVol   Volume
i1

lVolt  max  0, log 2  min(cVol, 2  kD  Threshold ) Threshold  

(2)

Cost  CostBeforeLearning *(1  LearningRate)lVolt
Cost  CostBeforeLearning *(1  LearningRate)( year StartYear )

(3)

Where: kD is the a constant representing a maximum of 2 reductions for learning, Volume
is the volume of deployment of the technology, Threshold is the threshold volume and is
from the technology input assumptions, LearningRate is the rate of decline from the input
technology assumptions.
If LearningType is left blank or is set to none, then the standard cost method is used,
otherwise the indicated learning method (VOLUME or TIME) is used. Reduction due to
learning do not take place in the CAFE Model until the technology is available and applied.
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Other fields in the input assumptions are the TechType and Abbr. Abbr contains
abbreviations of the technology. The TechType field specifies the technology group.
Technology groups are shown in Table 2 on page 6. Technology groups are discussed below.
The CAFE Model uses estimates of each technology’s impact on cost and fuel consumption
when selecting which technologies to apply to which vehicles in order to achieve compliance
with CAFE standards.
Further discussion of the technology input assumptions can be found in Appendix C.
2.2.2.7

Technology Groups:

Technology groups, as shown in Table 2 on page 6, organizes the technologies into
functional groups and allows the model to seek the next “best” technology application in any
of the groups.5 There are seven groups: engine technologies; transmission technologies;
electrical accessory technologies; dynamic load reduction technologies; aerodynamic load
reduction technologies; material substitution technologies; and hybrid electric vehicle
technologies.
2.2.2.8

Backfill of Technologies

In some cases, technologies will be bypassed because they are not cost-effective. If the
model applies a technology that resides later in the sequence, the model will ‘backfill’ any
bypassed technologies. This backfill will not occur if the technology is not applicable to the
vehicle. In the case where the backfill would backtrack through branches in the sequence,
the model would first resolve any limitations and applicability issues. If the branch still
exists, it would examine which is the more cost-effective branch to use.
Unless the current model year is the first or only model year in the study period, the
compliance simulation algorithm first applies any technologies that should be “carried over”
from the previous model year. This carryover is implemented based on any “predecessor”
relationships specified in the market data input file, and increases the cost and fuel
economy of affected vehicles in the current model year.6 Carrying over technologies between
model years based on such relationships avoids some unlikely predictions, such as that a
given technology would be added to a given vehicle model in one model year and then
removed in the following model year.
The algorithm next determines the applicability of each technology to each vehicle model,
engine, and transmission. If the technology is available in the current model year, the
5

Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective. The
system assumes that the manufacturer will seek to progress through the technology decision trees in a manner that
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b)
reductions in civil penalties owed for noncompliance with CAFE standards, and (c) the value vehicle purchasers are
estimated to place on fuel economy.
6

Because it occurs without reference to CAFE standards applicable to the current model year, this technology
carryover can cause overcompliance with one or more CAFE standards, depending on overall changes in the
manufacturer’s fleet.
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system identifies the technology as potentially applicable. However, technology “overrides”
can be specified for specific vehicle models, engines, and transmissions in the corresponding
input files.7 If any such overrides have been specified, the algorithm reevaluates
applicability as shown in

Figure 7.
2.2.2.9

Technology Sequencing and Branching

The sequence of applying technology works in the following way: Within each group, the
technology sequence of application proceeds as shown in the technology input file (Appendix
D.4). There are some points where the sequence path can branch onto a different course, as
discussed below. The groups are independent of each other, although there are some
interactions, as described below.
2.2.2.9.1

Sequencing and branching within a technology group

Within each technology group, the choice of technologies that can be applied may vary from
vehicle to vehicle based on the baseline configuration of the vehicle or on the previous
application of technologies. Both the engine and transmission technology groups have
optional paths. The choice of which path depends upon a variety of factors which include
the vehicle class, the vehicle configuration, technology override settings for that vehicle,
previous applications of technology, technology availability (year available) and phase-in
restrictions. When left with a choice of two or more technologies, cost-effectiveness is used
to choose the technology to apply.
2.2.2.9.2

Bypassing a Technology

In cases where a technology is already installed in the baseline vehicle configuration or is
unavailable for other reasons (e.g., it is not compatible with this vehicle class), then that
technology is simply bypassed in the technology path. For example, if engine friction
reduction has previously been installed, then the next available engine technology after low
-cost lubricants on a vehicle with overhead valves (OHV) is cylinder deactivation.
Branching within a technology group sequence occurs for the following reasons: 1) A normal
branch where there are two or more different (and mutually incompatible) technology
choices – the model can choose one or another path; 2) Limitations of technology choice
based on vehicle configuration; 3) A combination of both.
Examples of normal branches are DVVLD and CVVL in the engine technology group and
CVT or NAUTO in the transmission technology group.
7

These overrides, described in Appendix C.2 on page 60, provide a means of accounting for engineering and other
issues not otherwise represented by input data or the overall system.
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An example of the limitations would be within the engine technology group, as shown in

Figure 2, below, where there is a separate path for engines with overhead valves (OHV)
engines, single overhead cam engines (SOHC) and for engines with dual overhead cams
(DOHC).
2.2.2.9.3

Engine Technology Sequencing and Branching

Within the engine technology sequence, shown in

Figure 2, there are three major sequence paths: single overhead cam (SOHC); dual
overhead cam (DOHC); and overhead valve (OHV). The choice of path for a vehicle model is
based on the base engine attributes. There are further branches within the DOHC branch
and within the OHV path. The choice of which branch to take is based on availability for
the specific vehicle as well as the vehicle class; phase-in constraints; and, finally, costeffectiveness.
Further down within the engine technology sequence is another branch which culminates
in dieselization. The choice of which branch is, again, based on availability for the specific
vehicle as well as the vehicle class; phase-in constraints; and, finally, cost-effectiveness.
2.2.2.9.4

Transmission Technology Sequencing and Branching

Within the transmission technology sequence, for vehicles with a base 4- or 5-speed
automatic transmission, there are branch options based in part on vehicle attributes
(unibody versus ladder frame). Further criteria used to decide which branch to take are
availability for the specific vehicle as well as the vehicle class; phase-in constraints; and,
finally, cost-effectiveness. Manual transmissions remain in their own path. The sequence
for transmission technologies is shown in

Figure 3.
The transmission technologies and those on the electrical accessory path are considered
enabler technologies that must be installed on a vehicle prior to the application of the
strong hybrid technologies. Therefore, the model fully (i.e., as subject to all other
constraints) applies technologies in both of these paths before applying power-split, twomode, or plug-in hybrid technologies
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2.2.2.9.5

Electrical Accessory Technology Sequence

The electrical accessory technology sequence has no branches, as shown in

Figure 5. This group is an enabler for strong hybrid technologies.
2.2.2.9.6

Strong Hybrid Technology Options

As discussed above, the transmission technology and electrical accessory technology
sequences are enablers for strong hybrid technologies.
Once currently-available
opportunities to add technologies on these two sequences have been exhausted, the system
evaluates opportunities to apply strong hybrids. As shown in
Figure 6, which also illustrates the enabling nature of the transmission and electrical
accessory sequences, the system selects among power split, two-mode, and plug-in hybrids.
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Figure 2. Engine Technology Group Technology Sequence
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Figure 3. Transmission Technology Group Technology Sequence

Figure 4. Other Vehicle Technology Sequencing.
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Figure 5. Electrical Accessory Technology Group Sequencing
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Figure 6. Strong Hybrid Electric Vehicle Options
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Figure 7. Technology Applicability Determination
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2.2.3

Compliance Simulation Loop

If a given technology is still considered applicable after considering any overrides, the
algorithm again reevaluates applicability based the following engineering conditions:
Table 4. Engineering Conditions for Technology Applicability

Technology
All technologies
Low-Friction Lubricants
Variable Valve Timing Family
Variable Valve Lift and Timing
Family
Cylinder Deactivation
Turbocharging and downsizing
Stoichiometric GDI
Continuously Variable Transmission
Material Substitution

Constraint
Do not apply if already present on the vehicle.
Do not apply if engine oil is better than 5W30
Do not apply to diesel or rotary engines.
Do not apply to diesel or rotary engines. Do not apply to vehicles with
VVLT technology already in place. Once a VVLT (continuous or discrete)
are applied, the other VVLT cannot be applied.
Do not apply to engines with inline configuration, and/or fewer than 6
cylinders. Do not apply to diesel or rotary engines.
Do not apply to diesel or rotary engines.
Do not apply to diesel or rotary engines.
Apply only to FWD unibody vehicles.
Do not apply to vehicles with curb weights below 5,000 pounds.8

Having determined the applicability of each technology to each vehicle model, engine,
and/or transmission, the compliance simulation algorithm begins the process of applying
technologies based on the CAFE standards applicable during the current model year. This
involves repeatedly evaluating the degree of noncompliance, identifying the “best next” (as
described above) technology available on each of the parallel technology paths mentioned
above, and applying the best of these.
Figure 8 gives an overview of the process. If, considering all regulatory classes, the
manufacturer owes no CAFE fines, then the algorithm applies no technologies beyond any
carried over from the previous model year, because the manufacturer is already in
compliance with the standard. If the manufacturer does owe CAFE fines, then the
algorithm first finds the best next applicable technology in each of the technology groups
(e.g., engine technologies), and applies the same criterion to select the best among these. If
this manufacturer is assumed to be unwilling to pay CAFE fines (or, equivalently, if the
user has set the system to exclude the possibility of paying fines as long as some technology
can still be applied), then the algorithm applies the technology to the affected vehicles. If
the manufacturer is assumed to be willing to pay CAFE fines and applying this technology
would have a lower “effective cost” (discussed below) than simply paying fines, then the
algorithm also applies the technology. In either case, the algorithm then reevaluates the
8

This constraint it is not an inherent engineering constraint such as the constraint preventing SGDI from being
applied to diesel engines. It is based on a judgment by NHTSA that vehicle safety may be negatively impacted if
material substitution is applied to these vehicles. In the current version of the modeling system, this constraint can
be changed through reprogramming the model. Future versions may offer the ability to control this constraint
through an input to the model.
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manufacturer’s degree of noncompliance. If, however, the manufacturer is assumed to be
willing to pay CAFE fines and doing so would be less expensive than applying the best next
technology, then the algorithm stops applying technology to this manufacturer’s products.
After this process is repeated for each manufacturer, the compliance simulation algorithm
concludes.

Figure 8. Compliance Simulation Algorithm

Whether or not the manufacturer is assumed to be willing to pay CAFE fines, the algorithm
uses CAFE fines not only to determine whether compliance has been achieved, but also to
determine the relative attractiveness of different potential applications of technologies.
Whenever the algorithm is evaluating the potential application of a technology, it considers
the effective cost of applying that technology to the group of vehicles in question, and
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chooses the option that yields the lowest effective cost.9 The effective cost is used for
evaluating the relative attractiveness of different technology applications, not for actual
cost accounting. The effective cost is defined as the change in total technology costs
incurred by the manufacturer plus the change in CAFE fines incurred by the manufacturer
minus the value of any reduction of fuel consumed by vehicles sold by the manufacturer:

COSTeff 

TECHCOST  FINE VALUEFUEL
Nj

(4)

where ΔTECHCOST is simply the product of the unit cost of the technology and the total
sales (Nj) of the affected cohort of vehicles (j). The value of the reduction in fuel
consumption achieved by applying the technology in question to all vehicles i in cohort j is
calculated as follows:10


v  PB SURVv MI v FUELPRICEMY  v  1
1 
VALUEFUEL   i j  N i  v 0



v 0.5
(1  gap) 1  r 
 FEi FEi 


(5)

where MIv is the number of miles driven in a year at a given vintage v, SURVv is the
probability that a vehicle of that vintage will remain in service, FEi and FEi are the
vehicle’s fuel economy prior to and after the pending application of technology, gap is the
relative difference between on-road and laboratory fuel economy, Ni is the sales volume for
model i in the current model year MY, FUELPRICEMY+v is the price of fuel in year MY+v,
and PB is a “payback period”, or number of years in the future the consumer is assumed to
take into account when considering fuel savings. As discussed in Appendix C, MIv,
SURVv,FUELPRICEMY+v, and PB are all specified in the scenarios file.
In equation ( 4 ), FINE is the change in total CAFE fines (i.e., accounting for all regulatory
classes in the current CAFE scenario and model year). Typically, FINE is negative because
applying a technology would increase CAFE.11 FINE is calculated by evaluating the
following before and after the pending technology application, and taking the difference
between the results:

FINE  k F  MIN  CREDITC ,0 

(6)

C

Here, kF is in dollars per mpg (e.g., $55/mpg) and specified in the scenarios file.
9

Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given
engine, that engine might be used by a station wagon in the domestic passenger automobile fleet, a large car in the
imported passenger automobile fleet, and a minivan in the nonpassenger automobile fleet. If the manufacturer’s
domestic and imported passenger automobile fleets both comply with the corresponding standard, the algorithm
accounts for the fact that upgrading this engine will incur costs and realize fuel savings for all three of these vehicle
models, but will only yield reductions of CAFE fines for the nonpassenger fleet.

10

This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer
is assumed to expect to be able impose without losing sales.
11

Exceptions can occur if materials substitution is applied under a weight-based system.
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Within each regulatory class C, the net amount of CAFE credit created (noncompliance
causes credit creation to be negative, which implies the use of CAFE credits) is calculated
by subtracting the CAFE level achieved by the class from the standard applicable to the
class, and multiplying the result by the number of vehicles in the class. Taking into account
attribute-based CAFE standards, this is expressed as follows:

CREDITC  N C STD
C  N C , A C   CAFE C  N C , FEC  



(7)

where AC is a vector containing the value of the relevant attribute for each vehicle model in
regulatory class C, CAFEC is the CAFE level for regulatory class C (e.g., if the standard
depends on curb weight, AC contains each vehicle model’s curb weight), FEC is a vector
containing the fuel economy level of each vehicle model in regulatory class C, NC is the total
sales volume for regulatory class C, NC is a vector containing the sales volume for each
vehicle model in regulatory class C, and STDC(NC ,AC) is a function defining the standard
applicable to regulatory class C.

Figure 9 gives an overview of the logic the algorithm follows in order to identify the best
next technology application for each technology group.
Within a given technology group, the algorithm considers technologies in the order in which
they appear. If the phase-in limit for a given technology has been reached, the algorithm
proceeds to the next technology. If not, the algorithm determines whether or not the
technology remains applicable to any sets of vehicles, evaluates the effect cost of applying
the technology to each such set, and identifies the application that would yield the lowest
effective cost.
As shown in
Figure 8, the algorithm repeats this process for each technology group, and then selects the
technology application yielding the lowest effective cost. As discussed above, the algorithm
operates subject to expectations of the willingness of each manufacturer to pay fines.
COSTeff is determined, as above, by equations ( 4 ), ( 5 ), ( 6 ) and ( 7 ), irrespective of the
manufacturer’s willingness to pay fines.
2.2.3.1

Multi-Year Processing

When simulating compliance with standards applicable in a given model year, prior
versions of the CAFE model added technologies only to vehicle models to be sold in that
model year (after first “carrying forward” any technologies applied in prior model years to
vehicle models still sold in the current model year). For example, when modeling the model
year 2014 in this manner, only vehicles with technologies enabled in 2014 will be candidate
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for technology application (beyond that entailed in carrying forward any technologies as
mentioned above). The effective cost of the technology application will include the
technology cost for that from that year minus the cost of fuel savings and reduction of fine,
all divided by the number of vehicles in which the technology is being applied.
The CAFE model has since been modified to account for multi-year planning effects—that
is, the ability of manufacturers to, in a given model year, apply more technology than
necessary to achieve compliance in that model year if doing so will be sufficiently
advantageous in terms carrying technology forward to future model years and thereby
facilitating compliance in those model years. For example, faced with CAFE standards
increasing between model years, a manufacturer redesigning many vehicles in early model
years and fewer in later model years might apply “extra” technology in order to carry that
technology forward. Depending on rate of increase in CAFE standards, the manufacturer’s
planned vehicle mix, and the manufacturer’s redesign plans, this approach may reduce
compliance costs in later model years.
Because the CAFE model performs compliance simulations starting with the first included
model year and progressing forward to the last model year, the simulation of multi-year
planning is implemented by “looking back” to earlier model years. When run in multi-year
mode, the model is allowed to ‘look back’ to previous years where a technology was enabled
on any vehicles but not used and consider ‘back-dating’ the application of that technology
when calculating the effective cost. If the model did not apply an enabled technology in
2012, nor in 2013, then that technology remains available for multi-year application in
2014. The effective-cost calculation includes the technology cost for 2012, 2013 and 2014, as
well as fuel savings and fine reduction for those years. The number of vehicles used to
divide the total of those terms is the sum of effected vehicles from all years. When the
application of technologies in earlier model years produces the lowest effective cost, the
model applies the technology accordingly and updates the solution for all affected model
years.
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Figure 9. Determination of "Best Next" Technology Application
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2.3

Calculation of Effects

This section describes how the CAFE modeling system estimates the effects of tightening or
reforming CAFE standards on energy use, as well as on emissions of greenhouse gases and
other air pollutants. These effects are caused by improvements in the fuel economy of
vehicle models as manufacturers respond to changes in the CAFE standards. This section
also describes how these energy use and environmental impacts are translated into
estimates of economic benefits or costs, and identifies which of these economic impacts are
borne privately by vehicle owners and by society as a whole.
The effects on energy use and emissions from tightening or reforming CAFE standards are
estimated separately for each individual vehicle model and vintage (model year) over its
expected life span in the U.S. vehicle fleet. A vehicle model’s life span extends from the
initial model year when it is produced and sold, through the year when vehicles produced
during that model year have reached the maximum age used in the CAFE model.12 Each of
these effects is measured by the difference in the value of a variable – such as total gallons
of fuel consumed by a vehicle model and vintage during a future calendar year – with the
baseline CAFE standard (usually the standard currently in effect for that class of vehicle)
remaining in effect, and its value if those vehicles were instead required to comply with a
stricter CAFE standard.
Although these effects are calculated for individual vehicle models and vintages, they are
typically reported at the aggregate level for all vehicle models in a CAFE class (domestic
automobiles, import automobiles, and light trucks) produced during each model year
affected by a proposed standard. These aggregated values are reported for each future
calendar year during which a model year remains in the vehicle fleet. Cumulative impacts
for each CAFE class and model year over its expected life span are also reported, both in
undiscounted terms and as their present value discounted to the calendar year when each
model year is produced.
2.3.1

Light-Duty Vehicle Sales and Fleet

The forecast number of new vehicles of a specific model k sold during a given model year
MY is:

nk ,MY  N MY Pk , MY

(8)

Where NMY indicates the forecast of total new light-duty vehicle sales during that model
year, and Pk,MY is the forecast market share of each vehicle model produced during that
year.
The number of vehicles of a specific model and vintage that remains in service during each
subsequent calendar year is calculated by multiplying the number originally produced by
estimates (model inputs) of the proportion that remain in service at each age. Thus the
12

We adopt the simplification that vehicle model years and calendar years are identical.
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number of vehicles of model k produced during model year MY that remain in use during a
future year t, or nk,MY,t, is:

nk ,MY ,t  nk , MY sk ,a

(9)

where sk,a denotes the proportion of vehicles of model k expected to remain in use at the age
(a) that vehicles produced during model year MY will have reached during year t, which is
defined as

a = t – MY .13
The model utilizes different schedules of expected survival rates by vehicle age for six
separate classes of light-duty vehicles, as reported in Appendix C. The CAFE model
assumes that these survival rates will not vary for future model years.
2.3.2

Vehicle Use and Total Mileage

The total number of miles driven by vehicles of a specific model and vintage (model year)
during each year they remain in the fleet is calculated by multiplying age-specific estimates
(model inputs) of annual miles driven per vehicle by the number of vehicles of that model
year remaining in service at their age during that future year. Thus the total miles driven
by vehicles of model k produced during model year MY that are expected to remain on the
road during year t, denoted Mk,MY,t is calculated as:

M k ,MY ,t  nk ,MY ,t mk ,a

( 10 )

where mk,,a is the average number of miles that a surviving vehicle of model k is driven
when it has reached age a, defined above. The CAFE model uses separate estimates of
average annual utilization at different ages for different classes of light-duty vehicles. As
with survival rates, we assume that annual usage of vehicles of different types at each age
during their expected lifetimes will remain unchanged for future model years.
2.3.2.1

Accounting for the “Rebound Effect”

By reducing the amount of fuel it consumes per mile, improving a vehicle’s fuel economy
reduces its fuel cost per mile driven. In response to the reduced per-mile cost of driving a
more fuel-efficient vehicle, some buyers will increase the amount of driving they do,
although the precise magnitude of this response is uncertain. Thus, imposing stricter fuel
economy standards can increase the annual number of miles driven by vehicle models
whose fuel economy manufacturers elect to improve in their efforts to comply with those

13

We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when t=MY. Thus, for
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015. Because we do not
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to
survive to each age, a vehicle’s age is depends only on the difference between its model year (MY) and the calendar
year (t) for which these calculations are performed, and not on their specific values.
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standards.14 This increase in the use of vehicles with increased fuel economy is referred to
as the “rebound effect” in vehicle use.
The rebound effect results in a corresponding increase in the total number of miles driven
by vehicles produced during each model year affected by the stricter standards for every
year they remain in the fleet. The proportional increase in the average annual number of
miles driven during year t by a vehicle model k when its fuel economy is improved from the
level specified by its manufacturer’s product plan for its model year, denoted mpgk,MY,plan, to
a higher level, mpgk,MY,CAFE, is calculated using the elasticity of travel demand with respect
to the fuel cost of driving:

mk , MY ,t ,CAFE
mk , MY ,t

ft
ft


 mpg
mpg k , plan
k ,CAFE
  cpm 
ft


mpg k , plan









( 11 )

where εcpm (a model input) is the elasticity of vehicle use with respect to the cost of fuel per
mile driven (a measure closely related to the magnitude of the rebound effect), and ft is the
price of fuel per gallon during future year t . Because the fuel cost per mile driven by any
vehicle is equal to the price of fuel per gallon divided by its fuel economy in miles per
gallon, the bracketed term in equation ( 11 ) represents the proportional reduction in fuel
cost per mile driven resulting from the improvement in fuel economy.15
Thus, the absolute increase in average miles driven by vehicles of model k during year t
that results from an increase in the applicable CAFE standard is:

 mpg k , MY , plan

mk , MY ,t ,CAFE   cpm 
1 mk , MY ,t
 mpg

k , MY ,CAFE



( 12 )

Finally, the increase in the total number of miles driven by all surviving vehicles of model k
and model year MY during each future year t that some remain in the fleet, denoted
Mk,MY,t,CAFE is calculated from:

M k , MY ,t ,CAFE  nk , MY ,t mk , MY ,t ,CAFE

( 13 )

where nk,MY,t is given by equation ( 9 ).
Total miles driven each year increases due to the rebound effect only for those vehicle
models whose fuel economy is improved as part of their manufacturers’ efforts to comply
with a stricter CAFE standard. In contrast, there is no increase in annual usage of vehicle
14

The rebound effect also produces additional benefits to vehicle owners in the form of consumer surplus from the
increase in driving, which is discussed in Section C.6.
15

For Equation (11) to be strictly correct, mpg must represent actual “on the road” fuel economy. The difference
between laboratory test and actual on-road fuel economy is discussed in detail in Section C.2. below.
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models whose fuel economy remains unchanged from the level specified in manufacturers’
product plans for that model year.
The existence of the rebound effect also means that any scenario requiring a vehicle
manufacturer to increase the fuel economy of some models from those indicated in its
product plan for that model year will result in an increase in their use over each year of
their expected lifetime. In particular, where a manufacturer’s product plan specifies fuel
economy levels that do not meet the CAFE standard in effect during the previous model
year, the increase in their fuel economy necessary to ensure compliance with the baseline
standard will produce a slight increase in their lifetime use through the rebound effect.
The effect on total annual mileage driven resulting from substituting a new CAFE standard
(denoted CAFE1) for a previous standard (CAFE0) is the difference in the added driving
from the rebound effects associated with the two standards:

M k ,a ,t ,CAFE1  M k ,a ,t ,CAFE 0  nk ,a ,t  mk , a ,t ,CAFE1  mk ,a ,t ,CAFE 0 
2.3.3

( 14 )

Fuel Use and Savings

Fuel consumption by vehicles of each specific model and vintage during a future year
depends on the total mileage that the surviving vehicles are driven during that year, and
the average fuel efficiency they obtain in actual driving. Computing this value is affected by
the presence of the rebound effect, which as discussed previously causes slightly higher
annual usage throughout the lifetime of any vehicle model whose fuel economy is improved
above the level specified in its manufacturer’s product plan.
The computation is also affected by the difference between the fuel economy levels of new
vehicles as measured for purposes of assessing CAFE compliance and the (lower) levels
they actually achieve in real-world driving. Finally, it is also necessary to calculate fuel use
separately for gasoline and diesel vehicles, since these fuels result in different levels of
greenhouse gas and air pollutant emissions.
The number of gallons of fuel consumed by vehicles of model k and model year MY during
year t, denoted gk,MY,t, is calculated from:

g k , MY ,t 

M k , MY ,t  M k , MY ,t

mpg k , MY 1 gap 

( 15 )

where gap (a model input) indicates the difference between that model’s fuel economy as
measured for CAFE purposes and its actual on-road fuel economy. We assume that a
vehicle’s fuel economy is constant with respect to both age and accumulated mileage, and
that the test versus on-road fuel economy gap is identical for all vehicle types and ages.16

16

These assumptions explain the absence of an age subscript on mpg, and of all subscripts on the parameter gap.
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When the value of mpgk,MY in this expression corresponds exactly to the value specified in
the product plan submitted by vehicle k’s manufacturer for model year MY, there is no
rebound effect (i.e., Mk,MY,t = 0), and

g k , MY ,t , plan 

M k , MY ,t

mpg k , MY , plan 1  gap 

( 16 )

For any vehicle model whose fuel efficiency its manufacturer elects to increase as part of its
strategy to comply with a CAFE standard (including an extension to future model years of
the prevailing standard), the appropriate form of equation ( 16 ) is:

g k , MY ,t ,CAFE 

M k , MY ,t  M k , MY ,t
mpg k , MY ,CAFE (1  gap)

( 17 )

or, equivalently:

g k , MY ,t ,CAFE 

M k , MY ,t
mpg k , MY ,CAFE (1  gap)



M k , MY ,t
mpg k , MY ,CAFE (1  gap)

( 18 )

where the second term on the right hand side represents the additional fuel consumption
attributable to the standard’s inducement of additional driving through the rebound effect.
The effect on total fuel use during year t resulting from substituting a different standard
(denoted CAFE1) for one previously in effect (CAFE0) is obtained by summing expression (
17 ) or ( 18 ) over all vehicle models produced during the model years to which the
alternative standard would apply:

Gt ,CAFE1   MY  k  g k , MY ,t ,CAFE1  g k , MY ,t ,CAFE 0 

( 19 )

Thus the change in fuel use that results from imposing a different CAFE standard is
always measured relative to expected fuel use with some baseline or comparison standard
in effect. A frequent assumption used is that this baseline standard would be an extension
of the CAFE standard that applied to vehicles produced during the preceding model year.
The fuel savings from imposing a stricter CAFE standard on vehicles produced during a
single model year MY over their expected lifetime are given by:

GMY ,CAFE1   t  k  g k , MY ,t ,CAFE1  g k , MY ,t ,CAFE 0 

( 20 )

An often more appropriate measure of these fuel savings is the present value of lifetime fuel
savings for model year MY vehicles, discounted to the year they are produced:

 g , MY ,t ,CAFE 0 
g
PV  GMY ,CAFE1    t  k  k , MY ,t ,CAFE1 t kMY

(1  d )
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where d is the annual discount rate.
2.3.4

Greenhouse Gas Emissions

Environmental impacts from petroleum use stem primarily from combustion of petroleum
products such as gasoline, and to a lesser extent from the use of fossil energy during
petroleum refining and in the transportation, storage, and distribution of refined products.
These impacts include emissions of greenhouse gases and “criteria” air pollutants currently
regulated under the Clean Air Act. Increasing CAFE standards will reduce gasoline
consumption and the amount of petroleum refined, and both of these effects will in turn
reduce emissions of greenhouse gases. While reduced gasoline refining will also lower
emissions of criteria pollutants, the increase in vehicle use that results from improving
their fuel economy via the rebound effect will raise emissions of these pollutants. Thus on
balance, raising CAFE standards can either reduce or increase emissions of criteria
pollutants, depending on the magnitude of the rebound effect, vehicles’ emission rates per
mile driven, and emissions produced during fuel refining and distribution.
Fuel savings from stricter light truck CAFE standards will result in lower emissions of
carbon dioxide, the primary greenhouse gas emitted during the refining, distribution, and
combustion of transportation fuels.17 Lower fuel consumption reduces carbon dioxide
emissions directly, because the largest source of these emissions in transportation is fuel
use in internal combustion engines. The CAFE model calculates reductions in carbon
dioxide emissions from vehicle operation by multiplying the reduction in the number of
gallons of fuel consumed by the carbon content per gallon of fuel and the ratio of carbon
dioxide emissions per unit of carbon consumed during the combustion process.18
Direct or “tailpipe” carbon dioxide emissions occurring during year t as a result of fuel
consumption by vehicles of model k produced during model year MY are calculated from
MWCO2/MWC, where cf indicates the carbon content (by weight) per gallon of fuel, and
MWCO2 and MWC are the molecular weights of carbon dioxide (44) and carbon (12). This
calculation is performed separately for carbon dioxide emissions resulting from gasoline
and diesel fuel combustion, since their carbon content per gallon differs. The carbon content
of gasoline used in the CAFE model is a weighted average of those for different types of
gasoline in use.
As with fuel consumption, the effect of a new CAFE standard on carbon dioxide emissions
from vehicle operation is measured by the difference in emissions with the new standard in
effect, and those under a baseline or other alternative standard. Denoting these CAFE1 and
CAFE0 as previously, the change in carbon dioxide emissions from fuel consumed by
vehicles of model k and model year MY during year t is:

17

Carbon dioxide emissions account for more than 97% of total greenhouse gas emissions from the refining and use
of transportation fuels; see U.S. Environmental Protection Agency, Draft Inventory of GHG Emissions and Sinks
(1990-1999), Tables ES-1 and ES-4, http://www.epa.gov/globalwarming/publications/emissions/us2001/energy.pdf.
18

Although the system does not explicitly account for incomplete conversion of carbon to carbon dioxide, input
values specifying carbon content can be adjusted accordingly (i.e., reduced to 99-99.5% of actual carbon content).
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Cktp, MY ,t ,CAFE1   g k , MY ,t ,CAFE1  g k , MY ,t ,CAFE 0  c f (MWCO2/MWC)

( 22 )

Again, this calculation is performed separately for carbon dioxide emissions from gasoline
and diesel fuel use. Its results are summed over the vehicle models and vintages affected by
a proposed CAFE standard to estimate its impact on carbon dioxide emissions during
future years, or over vehicle types and ages to estimate the proposed standard’s effect on
lifetime carbon dioxide emissions by vehicles produced during the model years it would
affect.
Increasing the stringency of CAFE standards will also affect carbon dioxide emissions
generated from combustion of fossil fuels used during petroleum extraction, transportation,
storage, and refining, as well as during storage and distribution of refined fuel. Carbon
dioxide emissions from each stage of the fuel production and distribution process are
calculated using estimates of carbon dioxide emissions per unit of fuel energy. These
estimates are converted to a per-gallon basis using the energy content per gallon of gasoline
and diesel, and summed to calculate total carbon dioxide emissions per gallon of fuel used.
For vehicles of model k and model year MY, total carbon dioxide emissions during year t
from fuel production, distribution, and use are calculated as:

Cktot,MY ,t  g k ,MY ,t  c f  cr  cd 

( 23 )

As above, cf (a model input) is the carbon content of each fuel type, cr includes carbon
emissions per gallon during crude petroleum extraction, transportation, and refining, cd
represents carbon emissions per gallon during storage and distribution of refined fuel.
The effect of increasing a baseline standard CAFE0 to a higher standard CAFE1 on total
carbon emissions from fuel production and use is:

Cktot, MY ,t ,CAFE1   g k , MY ,t ,CAFE1  g k , MY ,t ,CAFE 0   c f  r  cr  cd 

( 24 )

Again, this quantity can be summed over vehicle models and ages to estimate the effect of a
proposed CAFE standard on total carbon dioxide emissions during any future year, or over
vehicle types and years to estimate the proposed standard’s effect on lifetime carbon dioxide
emissions from vehicles it would affect.
2.3.5

Air Pollutant Emissions

Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants,
by-products of fuel combustion that are emitted by internal combustion engines as well as
during fuel production and distribution. Criteria pollutants emitted in significant
quantities by light-duty motor vehicles include carbon monoxide, various hydrocarbon
compounds, nitrogen oxides, sulfur dioxide, and fine particulate matter.
The increased use of vehicle models with improved fuel economy that occurs through the
rebound effect causes increased emissions of criteria pollutants, since federal standards
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regulate permissible emissions of these pollutants on a per-mile basis. The increases in
emissions of these pollutants during vehicle operation are estimated by multiplying the
increase in total miles driven by vehicles whose fuel economy is improved by their per-mile
emission rates for each pollutant.
Emissions of pollutant i resulting from the operation of vehicle model k and model year MY
during year t are calculated as:

Eitp,k ,MY ,t   M k ,MY ,t  M k , MY ,t  ei ,k ,a

( 25 )

where (Mk,MY,t + Mk,MY,t) is given by ( 25 ), and ei,ka, is emissions per mile of pollutant i by
vehicles of model k and model year m at age a = t - MY. Emission rates (model inputs) for
criteria air pollutants differ by vehicle type, size class, model year of production, and age.
Changes in the volume of fuel consumption from varying CAFE standards will also affect
emissions of criteria pollutants that occur during refining, distribution, and retailing of
gasoline and diesel fuel.19 As with greenhouse gas emissions, these “upstream” emissions
are estimated by applying emission factors for each criteria pollutant per unit of fuel
refined to the total volume of each type of fuel consumed with any specified CAFE standard
in effect.
Upstream emissions of pollutant i within the U.S. from producing and distributing each
type of fuel consumed by vehicles of model k and vintage MY during year t are:

Eiup, k , MY ,t  g k , MY ,t  r  ei , r  ei ,d 

( 26 )

where gk,MY,t is calculated from ( 26 ), r is the fraction of each fuel type refined domestically,
ei,r is emissions of pollutant i that occur during crude petroleum extraction, transportation,
and refining, and ei,d is emissions of that pollutant from the storage and distribution of
refined fuel. Both ei,r and ei,d are expressed per gallon of fuel produced.
Total emissions of a criteria pollutant i from the production, distribution, and use of fuel
are the sum of emissions during vehicle operation and from the production and distribution
of fuel:

Eitot, k , MY ,t  Eitp, k , MY ,t  Eiup, k , MY ,t

( 27 )

In turn, the effect on criteria pollutant emissions of a proposed increase to a standard
CAFE1 a baseline standard of CAFE0 is

19

Reductions in criteria pollutant emissions from fuel refining and distribution are calculated using input values
specifying emission rates. Argonne National Laboratories’ GREET model is an available source of such inputs; see
Argonne National Laboratories, The Greenhouse Gas and Regulated Emissions from Transportation (GREET)
Model, Version 1.6, February 2000, http://www.transportation.anl.gov/ttrdc/greet/index.html.
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Eitot, k , MY ,t ,CAFE1   M k , MY ,t ,CAFE1  M k , MY ,t ,CAFE 0  ei ,k , MY ,t
  g k , MY ,t ,CAFE1  g k , MY ,t ,CAFE 0  r  ei , r  ei , d 

( 28 )

Again, this quantity can be summed over model or calendar years to report annual or
lifetime effects of proposed CAFE standards on emissions of criteria pollutants.
Emissions of some criteria pollutants may potentially increase as a result of stricter CAFE
standards, as increased emissions from added driving due to the rebound effect outweigh
the reduction in emissions from gasoline refining and distribution. Of course, the likelihood
that this will occur this also depends on the magnitude of the rebound effect itself. For
other pollutants, however, emission rates during fuel production are large relative to those
from vehicle operation, so on balance, emissions of these pollutants are likely to decline as
CAFE standards are raised.
2.3.6

Private versus Social Costs and Benefits

Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs,
many of which affect buyers of those vehicles directly. Depending upon how manufacturers
attempt to recoup the costs they incur for improving the fuel efficiency of selected models,
buyers are likely to face higher prices for some – and perhaps even most – new vehicle
models. Purchasers of models whose fuel economy is improved benefit from the resulting
savings in the cost of fuel their vehicles consume, from any increase in the range they can
travel before needing to refuel, and from the added driving they do as a result of the
rebound effect.
At the same time, the reduction in fuel production and use resulting from improved fuel
economy produces certain additional benefits and costs to society as a whole. Potential
social benefits from reduced fuel use include any value that society or the U.S. economy
attaches to saving fuel over and above its private value to new vehicle buyers, lower
emissions of air pollutants and greenhouse gases generated by from fuel production,
distribution, and consumption, and reduced economic costs associated with U.S. imports of
crude petroleum and refined fuel. By causing some additional driving through the rebound
effect, improving fuel economy can also increase a variety of social costs, including the
economic value of health effects and property damages caused by increased air pollution,
the value of time delays to motorists from added traffic congestion, added costs of injuries
and property damage resulting from more frequent traffic accidents, and economic costs
from higher levels of traffic noise.
The following sections discuss how each of these benefits and costs can result from
improving the fuel economy of new vehicles, the factors affecting their likely magnitudes,
and how their values are commonly measured or estimated. Appendix D provides the
specific unit economic inputs and other parameters required to estimate the aggregate
value of these various benefits and costs.
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2.3.6.1

2.3.6.1.1

Benefits and Costs to New Vehicle Buyers:

Increases in New Vehicle Prices

Depending upon how manufacturers attempt to recover the costs they incur in complying
with CAFE regulations, purchase prices for some new models are likely to increase.
Because we assume that manufacturers fully recover all costs they incur for installing fuel
economy technologies to comply with CAFE in the form of higher prices for some models,
the total increase in vehicle sales prices has already been accounted for in estimating
technology costs to manufacturers. Nevertheless, the total value of these price increases
represent a cost of CAFE regulation from the viewpoint of buyers of vehicle models whose
prices rise.
In addition to increases in the prices paid by buyers who elect to purchase these models
even at their higher prices, higher prices result in losses in welfare or consumer surplus to
buyers who decide to purchase different models instead. However, the CAFE modeling
system does not currently estimate changes in buyers’ purchase decisions, and therefore
does not estimate corresponding changes in welfare or consumer surplus.
2.3.6.1.2

The Value of Fuel Savings

The CAFE modeling system estimates the economic value of fuel savings to buyers of new
vehicle models whose fuel economy is improved by applying the forecast (an input to the
model) of future retail fuel prices to each year’s estimated fuel savings for those models.
The annual fuel savings for a model during each year of its lifetime in the vehicle fleet is
multiplied by the number of those initially sold that are expected to remain in use during
that year to determine the total annual value of fuel savings to buyers of that model.
The forecast retail price of fuel per gallon—including federal and average state fuel and
other taxes—during that year is used to estimate the value of these fuel savings as viewed
from the perspective of their buyers. Based on evidence from previous studies of consumer
purchases of automobiles and durable appliances, we assume that new vehicle buyers value
these savings over the approximate number of years (an input to the model) they expect to
own a new vehicle, and that they discount these expected savings to the year in which they
purchase new vehicles.
2.3.6.1.3

Benefits from Additional Driving

The rebound effect also results in additional benefits to new vehicle buyers in the form of
consumer surplus from the increased driving it produces. These benefits arise from the
value to drivers and passengers of the social and economic opportunities made available to
them by additional traveling. As evidenced by the fact that they elect to make more
frequent or longer trips when improved fuel economy reduces the cost of driving, the
benefits from this additional travel exceed the costs drivers and their passengers incur in
making more frequent or longer trips. The amount by which these benefits from additional
travel exceed its cost to them—which has been reduced by improved fuel economy—
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represents the increase in consumer surplus associated with additional rebound effect
driving.
The system estimates the value of these benefits using the conventional approximation of
one half of the product of the decline in fuel cost per mile driven and the resulting increase
in the annual number of miles driven. This value is calculated for each year that a model
whose fuel economy is improved remains in the fleet, multiplied by the number of vehicles
of that model expected to remain in use during each year of its lifetime, and discounted to
its present value as of the year it was purchased. Given typical input values (e.g, for fuel
prices), this benefit is relatively small by comparison to most other economic impacts of
raising CAFE standards.
2.3.6.1.4

The Value of Extended Refueling Range

Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also
increase their driving range per tank of fuel. By reducing the frequency with which drivers
typically refuel their vehicles, and by extending the upper limit of the range they can travel
before requiring refueling, improving fuel economy thus provides some additional benefits
to their owners.20 No direct estimates of the value of extended vehicle range are readily
available, so the CAFE model calculates the reduction in the annual number of required
refueling cycles that results from improved fuel economy. The change in required refueling
frequency for vehicle models with improved fuel economy reflects the increased driving
associated with the rebound effect, as well as the increased driving range stemming from
higher fuel economy.
2.3.6.1.5

Changes in Performance and Utility

The system currently assumes that the costs and effects of fuel-saving technologies reflect
the application of these technologies in a manner that holds vehicle performance and utility
constant.
Therefore, the system currently does not estimate changes in vehicle
performance or utility.
2.3.6.1.6

2.3.6.1.6.1

Social Benefits and Costs from Increased Fuel Economy

The “Social Value” of Fuel Savings

The economic value to society of the annual fuel savings resulting from stricter CAFE
standards is also assessed by applying estimated future fuel prices to each year’s estimated
fuel savings. Unlike the value of fuel savings to vehicle buyers themselves, however, the
pre-tax price per gallon is used in assessing the value of fuel savings to the economy as a
whole. This is because reductions in payments of state and federal taxes by purchasers of
fuel will be exactly offset by reduced spending on the construction and maintenance of

20

If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices.
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streets and highways that fuel taxes are mainly used to finance, and thus do not reflect a
net savings in resources to the economy.
When estimating the nationwide aggregate economic benefits and costs from CAFE
regulation, we include this “social” value of fuel savings rather than their private value to
vehicle buyers. In computing the social value of fuel savings, we include their annual value
over the entire expected lifetimes of vehicle models whose fuel economy is improved,
reflecting the presumably longer-term horizon of society as a whole compared to that of
vehicle buyers, who may be concerned with fuel savings only over the time they expect to
own newly-purchased vehicles.
2.3.6.1.6.2

Economic Benefits from Reduced Petroleum Imports

Importing petroleum into the United States is widely believed to impose significant costs on
households and businesses that are not reflected in the market price for imported oil, and
thus are not borne by consumers of refined petroleum products. These costs include three
components: (1) higher costs for oil imports resulting from the combined effect of U.S.
import demand and OPEC market power on the world oil price; (2) the risk of reductions in
U.S. economic output and disruption of the domestic economy caused by sudden reductions
in the supply of imported oil; and (3) costs for maintaining a U.S. military presence to
secure imported oil supplies from unstable regions, and for maintaining the Strategic
Petroleum Reserve (SPR) to cushion against price increases. By reducing domestic demand
for gasoline, tighter CAFE standards can reduce petroleum imports, and thus reduce these
social costs to the extent that their magnitude varies with the volume of U.S. oil imports.
Any reduction in their magnitude represents an additional category of economic benefits
from tighter fuel economy standards.
In this analysis, the reduction in petroleum imports resulting from higher light truck CAFE
standards is estimated by assuming that the resulting savings in gasoline use during each
future year is translated directly into a corresponding reduction in the annual volume of
U.S. oil imports during that same year. The value to the U.S. economy of reducing
petroleum imports – in the form of lower crude oil prices and reduced risks of oil supply
disruptions – is estimated by applying the sum of the previously reported estimates of these
benefits to the estimated annual reduction in oil imports.
2.3.6.1.6.3

Valuing Changes in Environmental Impacts

The CAFE modeling system estimates the economic value of the net change in emissions of
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides,
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton
of emissions of each of these pollutants. As indicated previously, emissions of criteria
pollutants can rise or fall when fuel economy increases, so the economic costs of these
emissions can increase or decline in response to higher CAFE standards.
The model estimates changes in damage costs caused by carbon dioxide emissions by
multiplying the magnitude of the change in emissions by the estimated value of damages
per unit of emissions.
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2.3.6.1.7

Social Costs of Added Driving

In addition to increasing emissions of criteria pollutants, any added driving associated with
the fuel economy rebound effect may contribute to increased traffic congestion, motor
vehicle accidents, and highway noise. Additional vehicle use can contribute to traffic
congestion and delays partly by increasing recurring congestion on heavily-traveled
facilities during peak travel periods, depending on how the additional travel is distributed
over the day and on where it occurs. Added driving can also increase the frequency of
incidents such as collisions and disabled vehicles that cause prolonged delays, although the
extent to which it actually does do will again depend partly on when and where the added
travel occurs. Finally, added vehicle use from the rebound effect may also increase traffic
noise, which causes inconvenience, irritation, and potentially even discomfort to occupants
of other vehicles, pedestrians and other bystanders, and residents or occupants of
surrounding property.
The CAFE modeling system uses estimates of the increases in external costs – that is, the
marginal social costs – from added congestion, property damages and injuries in traffic
accidents, and noise levels caused by additional vehicle usage. It does so by applying
estimates of the increases in these costs that result from each added mile of travel by
different types of vehicles (passenger and nonpassenger automobiles) to the increase in the
total number of miles driven projected to result from the rebound effect.
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Appendix A

Installation

The CAFE Compliance and Effects Modeling System runs on IBM-compatible computers
using the Microsoft® Windows operating system. A processor speed of at least 1 GHz is
required, with 2 GHz and above highly recommended, as is physical RAM of at least 1 GB.21
The software has been developed on computers using Windows XP, but may operate
properly on machines using older versions of Windows (e.g., Windows 2000), or newer
versions (e.g., Windows Vista), as long as a compatible Microsoft® .NET Framework is
installed.
Because the software makes extensive use of Microsoft® Excel files for input and output,
Excel must be present. To provide a means of protecting confidential business information
(CBI) contained in input and output files (if the user is relying on CBI), the software makes
use of encryption algorithms available in Excel 2003. These algorithms are not available in
older versions of Excel. Unencrypted files may be used with such versions.
The software uses the Microsoft® .NET Framework. If the Framework is not already
present, it must be installed. Instructions are available on the Internet at
http://msdn.microsoft.com/netframework/downloads/framework1_1/.22
The software also used the Microsoft® Visual J# .NET Redistributable Package 1.1, which
can
be
obtained
on
the
Internet
at
http://msdn2.microsoft.com/en
us/vjsharp/bb188598.aspx.23
Once the .NET Framework and the Visual J# Redistributable have been successfully
installed, contact NHTSA or Volpe Center staff to obtain the files needed to install the
CAFE Compliance and Effects Modeling System. Those files will be accompanied by current
instructions for installing the system.
Based on the characteristics of machines used in the development of this software, Table 5
provides a summary of system requirements:
Table 5. System Requirements
1 GHz or faster processor (2GHz, recommended)
1 GB of RAM (2 GB, recommended)
Microsoft® Windows XP
Microsoft® Excel 2003
Microsoft® .NET Framework 1.1
Microsoft® Visual J# .NET Redistributable Package 1.1

21

If the software exhausts the available physical RAM, it will begin using the system’s virtual memory (i.e., the
hard disk) and will slow dramatically. Insufficient memory may also cause the software to behave unexpectedly.
22

The software is not compatible with other versions of the Framework (e.g., 1.0 or 2.0 and above) and will not
install or run unless the .NET Framework 1.1 is present on the system.
23

The software requires the Visual J# .NET Redistributable Package 1.1. Versions 1.0, 2.0, or 2.0 second edition are
not compatible.
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Appendix B

Appendix B.1

Operation

Install the software

Step 1: Install the software (see Appendix A) and put all the input files in a folder you can
find.
The input files are:


demo_parameters.xls: inputs used to calculate the energy and emissions of changes in vehicle
characteristics and sales volumes, as well as some assumptions used when simulating compliance



demo_emissions_rates.xls: inputs used to project the emissions rates of various pollutants



demo_market_data.xls: vehicle model, engine, and transmission characteristics and vehicle model
sales volumes



demo_scenarios.xls: inputs used to define different CAFE scenarios



demo_technologies.xls: technology cost, efficiency, and availability assumptions
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Run the program

Step 2: To run the CAFE model, open the model using the Start MenuCAFE
ModelCAFE Model to open the main control window.24


Read through the warnings and click the Yes button to continue (see Figure 10).

Figure 10. Warnings Dialog Box



The main control window opens (Figure 11).

Figure 11. Initial Main Control Window

24

Because the software slows dramatically if the physical RAM is fully utilized, we recommend closing other
applications while running the software.
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Appendix B.3

Create a new CAFE Session

Step 3: Create a new CAFE session, using the New Session Wizard. If you have previously
created a session, proceed to Step 4.


Select File > New Session, press Ctrl+N, or click on the new session button (

).

Figure 12. New Session Wizard Screen 1



Follow the instructions provided by the wizard (Figure 12). Click the next button (
continue.



Select the desired Compliance Model (Figure 13) type and click the next button. Additional
modeling types are available to assist in automated optimization and sensitivity analysis.
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Figure 13. Compliance Model Selection



Configure the Model Input by optionally specifying an input password and selecting the desired
input files.



If the input files are password protected, select the “Yes …” checkbox and click next (Figure 14).
Otherwise, simply click the next button.

Figure 14. Configure Model Input Window



If the input files are password protected, enter and verify the password to use for loading the
Excel files (Figure 15). Note: passwords are case sensitive. Click the next button to continue.
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Figure 15. Enter Password for Input Files



Select the desired Input Files by clicking on the browse buttons next to the textboxes or typing in
the file path directly (Figure 16).



You may also drag and drop single or multiple files into the wizard, or drag and drop a folder
containing the input files. The model will check and auto-select the files required for input.

Figure 16. Select Input Files



Select the desired Technology Settings and click the next button (Figure 17).
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Figure 17. Select Technology Settings



Configure the Model Output by optionally entering a password and selecting the desired reports
and output location (Figure 18).



If you decided to password-protect the output files, select the “Yes …” checkbox and click next.
Otherwise, simply click the next button.

Figure 18. Configure Model Output



Enter and verify the password to use for saving the Excel reports (Figure 19). Note: passwords
are case sensitive. Click the next button to continue.
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Figure 19. Enter Password for Output Files



Select the desired Reports and click next (Figure 20).

Figure 20. Select Reports



Select the Output Path where the model will write log files and reports by clicking the browse
button next to the textbox or by entering the folder location directly (Figure 21). Click the next
button to continue.
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Figure 21. Select Output Path
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Complete the New Session Wizard by entering a session name and clicking the apply button
(



)(Figure 22).

You may also save the newly created session after exiting the wizard.25

Figure 22. Completing the New Session Wizard



Wait for the wizard to complete loading files and settings.

Figure 23. Creating New Session

25

Saving sessions allows bypassing of the wizard during future runs, as long as the input files and settings remain
the same.
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All of the settings configured above, as well as the advanced options not available in the wizard,
are accessible by selecting Tools > Modeling Settings, pressing Ctrl+T, or clicking on the
configure modeling settings button (

).



The wizard for any existing session may be re-run by selecting Tools > Run New Session
Wizard or by pressing Ctrl+W.



If you decided to save the session after exiting the wizard, select the location for the session file
and click the Save button.

Figure 24. Saving the Session



Proceed to Step 5 (Appendix C on page 50).
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Open an existing CAFE Session.

Step 4: Open an existing CAFE Session. If you have created a new session in Step 3,
proceed to Step 5 (Appendix C below).


Select File > Open Session, press Ctrl+O, or click on the open session button (



Locate the previously saved session (file with an .cmsd extension) and click the Open button
(Figure 25).

).

Figure 25. Open an Existing Session File



To configure the modeling settings for the opened session, select Tools > Modeling Settings,
press Ctrl+T, or click on the configure modeling settings button (

).



You may re-run the New Session Wizard for any opened session by selecting Tools > Run New
Session Wizard or by pressing Ctrl+W.



Proceed to Step 5 (Appendix C below).
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Appendix C

Start the Modeling Process.

Step 5: Return to the main control window and start the modeling process.


Select File > Start Modeling, press Ctrl+M, or click the start modeling button (
now become enabled (Figure 26).

Figure 26. Running the Model
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While the compliance modeling process is running, the model displays various progress
information in the session body.

Figure 27. Model Run Example One

Figure 28. Model Run Example Two
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The modeling process has concluded when “Modeling Completed!” appears at the bottom of the
main control window (Figure 29).

Figure 29. Modeling Complete
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Appendix C.1

Generate the Modeling Reports.

Step 6: Generate the modeling reports.


To review the modeling reports selected for output, select Tools > Manage Output or press
Ctrl+U.

Figure 30. Manage Output for Modeling Reports



Select the desired reports, click save (

), then close (
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Generate the modeling reports by selecting File > Generate Reports or pressing Ctrl+R (Figure
31).

Figure 31. Generate Reports



Wait for “Reporting Completed!” to appear at the bottom of the main control window (Figure
32).

Figure 32. Reporting Complete
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Appendix C.2

Exit the CAFE modeling application.

Step 7: Exit the CAFE modeling application.


Select File > Exit, press Alt+F4, or click the close button (X) at the top-right corner of the main
control window.



A “Save Session?” dialog will appear (Figure 33). You may press Yes, to save the session, or No
(recommended), to discard saving the session.

Figure 33. Save Session Before Closing
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Appendix C.3

View results by opening appropriate output files.

Step 8: View results by opening appropriate output files.
The model saves all log files and reports to the output folder specified in Step 3, organized
by the session name. Thus, in the example session created in Step 3, the outputs will be
located under C:\cafe\demo-run\demo, where C:\cafe\demo-run\ is the selected output
path and “demo” is the name of the session.
The modeling reports for all included scenarios are saved in the reports folder (Figure 34).
The per-scenario reports are numbered in order of appearance, starting at 0. The first
scenario (0) is identified as the baseline scenario to which all others are compared. The
following files are produced if specified in Steps 3 (Appendix B.3) or 6 (Appendix C.1).


Industry_Report_Sn*.xls: Industry- and manufacturer-level summary of compliance model
results, showing all model years per worksheet for individual manufacturers and overall industry
results.



Manufacturer_Report_Sn*.xls: Industry- and manufacturer-level summary of compliance model
results, showing all manufacturers and overall industry results, with one model year per
worksheet.



Vehicles_Report_Sn*.xls: Vehicle-level summary of compliance model results.



Effects_Report_Sn*.xls: Summary of energy and emissions effects.



EA_Report.xls: Summary of fuel consumption and emissions effects.



ScenSummary_Report.xls: Summary of industry- and manufacturer-level compliance and effects
results, compared versus the baseline across all scenarios.

Figure 34. Reports Folder
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To review input files, modeling settings, and scenario descriptions used during modeling,
open Summary.txt, which is located in the logs folder (Figure 35).

Figure 35. Modeling Logs Folder

The logs folder also contains the Errors.txt file, which identifies errors that occurred during
modeling, the Warnings.txt file, which specifies any modeling warnings, and
compliance_*.txt files, which hold compliance findings applied to each of the manufacturers
during a specific scenario and model year.
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Appendix D

Inputs

Appendix D.1

Overview

In addition to various operational settings that are, as discussed in Appendix B, specified
by the user at the time the system is initiated, the system utilizes the five input files (all in
Microsoft® Excel format) shown Table 6. As discussed in Appendix B, the user specifies the
location of these files in the course of setting up a model run. The user can define and edit
all inputs to the system. For example, the system does not require market data constructed
using confidential business information.

Table 6. Input File Contents

Input File

Contents

Market Data

indexed list of manufacturers available during the study period, along with
manufacturer’s willingness to pay fines and other modeling settings.

(Manufacturers Worksheet)

Market Data
(Vehicles Worksheet)

Market Data
(Engines Worksheet)

Market Data
(Transmissions Worksheet)

Technologies

indexed list of vehicle models available during the study period, along with sales
volumes, fuel economy levels, prices, other attributes, domestic labor utilization,
references to specific engines and transmissions used, and optional settings related
to technology applicability, designation as a passenger or nonpassenger automobile,
and coverage of vehicles with GVWR above 8,500 pounds

indexed list of engines available during the study period, along with various engine
attributes and optional settings related to technology applicability

indexed list of transmissions available during the study period, along with various
transmission attributes and optional settings related to technology applicability

estimates of the availability, cost, and effectiveness of various technologies,
specific to various vehicle categories
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Scenarios

coverage, structure, and stringency of CAFE standards for scenarios to be simulated

Parameters

inputs used to calculate travel demand, fuel consumption, carbon dioxide and
criteria pollutant emissions, and economic externalities related to highway travel
and petroleum consumption

Emissions Rates

inputs used to project the emissions rates of various pollutants

59

DRAFT

Appendix D.2

Market Data File

The market data file has four worksheets, Manufacturers, Vehicle Models, Engines and
Transmissions.
Appendix D.2.1

Manufacturers Worksheet

The manufacturers input worksheet contains a list of all manufacturers that produce
vehicle models offered for sale during the study period. Each manufacturer has a unique
code and is represented by a unique manufacturer name. For each manufacturer, the
manufacturer code, name, cost allocation strategy, and willingness to pay CAFE fines must
all be specified. Available credits, if applicable, should be expressed in Vehicle/MPG and is
applied directly as a credit (or discredit if negative) to the CAFE level for the given
manufacturer in the given model year. If no available credits are to be specified, a value of
zero (0.0) can be used or the cell can be left blank.

Table 7. Manufacturers Worksheet

Available
Credits (vehmpg)

Willingness to
Pay CAFE
Fines

General

Category

Manufacturer Characteristic
Manufacturer Code
Manufacturer Name
Optimize

Units
integer
text
text

2011
2012
2013
2014
2015
2016
2011
2012
2013
2014
2015
2016

text
text
text
text
text
text
vehicle mpg
vehicle mpg
vehicle mpg
vehicle mpg
vehicle mpg
vehicle mpg

Definition/Notes
unique number assigned to each manufacturer
name of manufacturer
Y = consider this manufacturer for optimizatoin; N = do no consider for
optimization.
manufacturer's willingness to pay fines
Y = pay fines instead of applying ineffective technologies
N = apply ineffective technologies instead of paying fines

Values are applied toward (or, if negative, against) manufacturer's CAFE
level when determing compliance.
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Appendix D.2.2

Vehicle Models Worksheet

The vehicle models worksheet contains information regarding each vehicle model offered for
sale during the study period. Each vehicle model is represented as a single row of input
data. Table 8 through Table 11 list the different columns of information specified in the
vehicle models file. To make the information readable, the Vehicle Models tables are
presented vertically and divided into sections.
In the “General” category, the number, manufacturer, model, nameplate, fuel economy,
engine code, transmission code, and origin must be specified for each vehicle model. The
engine and transmission codes must refer to a valid engine and transmission, respectively,
for the relevant manufacturer in the engine and transmission input files.

Table 8. Vehicle Models Worksheet

General

Category Vehicle Characteristic
Number
Manufacturer
Model
Nameplate
Fuel Economy
Actual FE (FFVs)
Engine Code
Transmission Code
Origin
Technology Class
General Notes

Units
integer
text
text
text
mpg
mpg
integer
integer
text
text
text

Definition/Notes
unique number assigned to each model
manufacturer abbreviation
name of model (i.e., Camry)
vehicle nameplate (i.e., Camry Solara)
weighted (FTP+highway) fuel economy
for flexible fuel vehicles, fuel economy when vehicle is operated on gasoline
only
unique number assigned to each engine
unique number assigned to each transmission
classification as domestic or import
the technology class to which this vehicle belongs
explanatory notes

Within the “Vehicle” category, it is important that each vehicle model’s style, class, drive,
curb weight or test weight, wheelbase, front and rear track width, and fuel capacity be
specified. For any hybrid vehicle models, it is necessary to specify at least the type of
hybridization.
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Table 9. Vehicle Models Worksheet (continued)

Vehicle

Category Vehicle Characteristic
Style
Class
Structure
Drive

Units
text
text
text
text

Wheelbase
Track Width (front)

inches
inches

Track Width (rear)

inches

Footprint
Curb Weight

sq. feet
pounds

Test Weight

pounds

GVWR

pounds

Fuel Capacity

gallons

Seating (max)

integer

Type (Hybridization)
Vehicle Notes

text
text

Definition/Notes
vehicle style
vehicle class
vehicle structure (e.g., ladder, unibody)
vehicle drive (e.g., A=all-wheel drive; F=front-wheel drive; R=rear-wheel-drive;
4=4-wheel drive)
per SAE J1100, L101 (Sept. 2005)
per SAE J1100, W101-1 (Sept. 2005), measured when tires are mounted on
rims with zero offset
per SAE J1100, W101-2 (Sept. 2005), measured when tires are mounted on
rims with zero offset
wheelbase times average track width
total weight of vehicle including batteries, lubricants, and other expendable
supplies but excluding the driver, passengers, and other payloads (SAE
J1100)
weight of vehicle as tested, including the driver, operator (if necessary), and
all instrumentation (SAE J1263)
Gross Vehicle Weight Rating; weight of loaded vehicle, including
passengers and cargo
gallons of diesel fuel or gasoline; MJ (LHV) of other fuels (or chemical
battery energy)
number of usable seat belts before folding and removal of seats (where
accomplished without special tools)
type of hybridization, if any
explanatory notes

In the “Planning & Assembly” section, it is important that the number of any (single)
predecessor to the current vehicle model be specified. The redesign and refresh years must
be comma separated and contain all known previous and projected future redesign and
refresh years. Known or projected sales are specified in the “Sales” section for each model
year in which the model is offered. Changes to a model—in particular any that would affect
fuel economy (e.g., a different engine or transmission)—are specified by creating a new row
(effectively a new vehicle model) with the older model’s number in the “predecessor” field.
The known or projected MSRP should be specified in its corresponding section for each
model year in which the vehicle model is offered for sale.
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Table 10. Vehicle Models Worksheet

MSRP

Sales

Planning & Assembly

Category Vehicle Characteristic
US Content
Canadian Content
Mexican Content
Predecessor
Redesign Years
Refresh Years
Employment Hours Per Vehicle
% 2 DR Cars
Market Segment - Auto News
Planning & Assembly Notes
MY2011
MY2012
MY2013
MY2014
MY2015
Sales Notes
MY2011
MY2012
MY2013
MY2014
MY2015
MSRP Notes

Units
percent
percent
percent
integer
model year
model year
hours
percent
integer
text
units
units
units
units
units
text
dollars
dollars
dollars
dollars
dollars
text

Definition/Notes
overall percentage, by value, that originated in U.S.
overall percentage, by value, that originated in Canada
overall percentage, by value, that originated in Mexico
number of model upon which current model is based
comma separated list of previous and future redesign years of the vehicle
comma separated list of previous and future refresh years of the vehicle
number of hours of U.S. labor applied per vehicle produced
share of vehicle models with 2 or 3 doors
coded market share per 2002 Automotive News Mark et Classifications
explanatory notes
projected production for sale in U.S.
projected production for sale in U.S.
projected production for sale in U.S.
projected production for sale in U.S.
projected production for sale in U.S.
explanatory notes
projected average MSRP (sales-weighted, including options)
projected average MSRP (sales-weighted, including options)
projected average MSRP (sales-weighted, including options)
projected average MSRP (sales-weighted, including options)
projected average MSRP (sales-weighted, including options)
explanatory notes

The applicability of technologies considered on a vehicle model basis (as opposed, for
example, to an engine basis) can be controlled for each vehicle model by using the
“Technology Applicability Overrides”. As discussed in section 2.2.2, the applicability of a
given technology to a given vehicle is first tested by considering the choice of “technology
path” specified in the technology input file (discussed below). However, if any overrides are
specified in the vehicle models file, they will preempt the technology path.
Table 11. Vehicle Models Worksheet

Technology Applicability Overrides

Category Vehicle Characteristic
EPS
IACC
MHEV
HVIA
BISG

Units
text
text
text
text
text

CISG

text

PSHEV
2MHEV
PHEV
MS1
MS2
MS5
ROLL
LDB
SAXU

text
text
text
text
text
text
text
text
text

SAXL

text

AERO

text

Definition/Notes
force system to set
force system to set
force system to set
force system to set
force system to set
Generator
force system to set
Generator
force system to set
force system to set
force system to set
force system to set
force system to set
force system to set
force system to set
force system to set
force system to set
Unibody
force system to set
Ladder Frame
force system to set
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as
as
as
as
as

"USED"
"USED"
"USED"
"USED"
"USED"

or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"

Electric Power Steering
Improved Accessories
12V Micro-Hybrid
Higher Voltage/Improved Alternator
Belt mounted Integrated Starter

as "USED" or "SKIP" Crank mounted Integrated Starter
as
as
as
as
as
as
as
as
as

"USED"
"USED"
"USED"
"USED"
"USED"
"USED"
"USED"
"USED"
"USED"

or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"
or "SKIP"

Power Split Hybrid
2-Mode Hybrid
Plug-in Hybrid
Material Substitution (1%)
Material Substitution (2%)
Material Substitution (5%)
Low Rolling Resistance Tires
Low Drag Brakes
Secondary Axle Disconnect -

as "USED" or "SKIP" Secondary Axle Disconnect as "USED" or "SKIP" Aero Drag Reduction
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Appendix D.2.3

Engines Worksheet

Similar to the vehicle models input file, the engines input worksheet contains a list of all
engines used in vehicle models offered for sale during the study period. For each
manufacturer, the engine code is a unique number assigned to each such engine. This code
is referenced in the engine code field of the vehicle models input file. For each engine, the
engine code, manufacturer, fuel, cycle, aspiration, number of cylinders, number of valves
per cylinder, and horsepower must all be specified. As in the vehicle models worksheet,
technology path overrides for any engine technology can be specified for any specific engine.
Table 12. Engines Input Worksheet
Engine Characteristic
Engine Code
Manufacturer
Name
Configuration
Fuel
Country of Origin
Engine Oil Viscosity

Units
integer
text
text
text
text
text
text

Cycle
Air/Fuel Ratio
Fuel System
Aspiration
Valvetrain Design

text
number
text
text
text

Valve Actuation/Timing
Valve Lift

text
text

Cylinders
Valves/Cylinder
Deactivation
Displacement
Compression Ratio (Min)
Compression Ratio (max)
Horsepower
Torque
Engine Notes
LUB
EFR
CCPS
DVVLS
DEACS
ICP
DCP
DVVLD
CVVL
DEACD
DEACO
CCPO
DVVLO
CDOHC
SGDI
CBRST
TRBDS
EGRB
DSLT
DSLC

integer
integer
text
liters
number
number
number
number
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text
text

Definition/Notes
unique number assigned to each engine
manufacturer abbreviation
name of engine
configuration of the engine
most common fuel with which engine is compatible
name of country where engine is manufactured
ratio between the applied shear stress and the rate of shear, which measures the
resistance of flow of the engine oil (as per SAE Glossary of Automotive Terms)
combustion cycle
weighted (FTP+highway) air/fuel ratio (mass)
mechanism that delivers fuel to engine
breathing or induction process of engine (as per SAE Automotive Dictionary)
design of the total mechanism from camshaft to valve of an engine that actuates the
lifting and closing of a valve (as per SAE Automotive Dictionary)
valve opening and closing points in the operating cycle (SAE J604)
the manner in which the valve is raised during combustion (as per SAE Automotive
Dictionary)
number of engine cylinders
number of valves per cylinder
weighted (FTP+highway) aggregate degree of deactivation
total volume displaced by a piston in a single stroke
for fixed CR engines, should be identical to maximum CR
for fixed CR engines, should be identical to minimum CR
maximum power (horsepower)
maximum torque (pound-foot)
explanatory notes
force system to set as "USED" or "SKIP" Low Friction Lubricants
force system to set as "USED" or "SKIP" Engine Friction Reduction
force system to set as "USED" or "SKIP" VVT - Coupled Cam Phasing (CCP) on SOHC
force system to set as "USED" or "SKIP" Discrete Variable Valve Lift (DVVL) on SOHC
force system to set as "USED" or "SKIP" Cylinder Deactivation on SOHC
force system to set as "USED" or "SKIP" VVT - Intake Cam Phasing (ICP)
force system to set as "USED" or "SKIP" VVT - Dual Cam Phasing (DCP)
force system to set as "USED" or "SKIP" Discrete Variable Valve Lift (DVVL) on DOHC
force system to set as "USED" or "SKIP" Continuously Variable Valve Lift (CVVL)
force system to set as "USED" or "SKIP" Cylinder Deactivation on DOHC
force system to set as "USED" or "SKIP" Cylinder Deactivation on OHV
force system to set as "USED" or "SKIP" VVT - Coupled Cam Phasing (CCP) on OHV
force system to set as "USED" or "SKIP" Discrete Variable Valve Lift (DVVL) on OHV
force system to set as "USED" or "SKIP" Conversion to DOHC with DCP
force system to set as "USED" or "SKIP" Stoichiometric Gasoline Direct Injection (GDI)
force system to set as "USED" or "SKIP" Combustion Restart
force system to set as "USED" or "SKIP" Turbocharging and Downsizing
force system to set as "USED" or "SKIP" Exhaust Gas Recirculation (EGR) Boost
force system to set as "USED" or "SKIP" Conversion to Diesel following TRBDS
force system to set as "USED" or "SKIP" Conversion to Diesel following CBRST

64

DRAFT

Appendix D.3

Transmissions Worksheet

Similar to the vehicle models and engines input worksheets, the transmissions input
worksheet contains a list of all transmissions used in vehicle models offered for sale during
the study period. For each manufacturer, the transmission code is a unique number
assigned to each such transmission. This code is referenced in the transmission code field of
the vehicle models input file. For each transmission, the transmission code, manufacturer,
type, number of forward gears, and control must all be specified. As in the vehicle models
input worksheet, technology path overrides for any transmission technology can be
specified for any specific transmission.

Table 13. Transmission Input Worksheet

Transmission Characteristic
Transmission Code
Manufacturer
Name
Country of Origin
Type
Number of Forward Gears
Control
Logic
Transmission Notes
6MAN
IATC

Units
integer
text
text
text
text
integer
text
text
text
text
text

CVT
NAUTO

text
text

DCTAM

text

Definition/Notes
unique number assigned to each transmission
manufacturer abbreviation
name of transmission
name of country where transmission is manufactured
type of transmission
ASMT would be coded as Type=C, Control=A
aggressivity of automatic shifting
explanatory notes
force system to set as "USED" or "SKIP" 6 Speed Manual Transmission
force system to set as "USED" or "SKIP" Improved Automatic Transmission
Controls/Externals
force system to set as "USED" or "SKIP" Continuously Variable Transmission
force system to set as "USED" or "SKIP" 6/7/8-Speed Automatic Transmission with
Improved Internals
force system to set as "USED" or "SKIP" Dual Clutch or Automated Manual Transmission

Taken together, the manufacturers, vehicle models, engines, and transmissions input files
provide “initial state” historical and/or forecast data for the light vehicle fleet.
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Technologies

The technologies input file contains assumptions regarding the fuel consumption benefit,
cost, applicability, and availability of different vehicle, engine, and transmission
technologies during the study period. Input assumptions are specific to each of the following
vehicle types: small SUVs, midsize SUVs, large SUVs, minivans, small pickups, large
pickups, subcompact cars, compact cars, midsize cars, and large cars. Table 14 shows
sample technology assumptions for subcompact cars:

Table 14. Technologies Input File (Sample)
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For each technology, Table 14 contains the following:
Index:

index of the technology, which loosely reflects the sequence to follow
when populating technology groups

Technology:

full technology name

Abbr.:

technology abbreviation used in code and output files

TechType:

technology group into which to place technology

Year Avail:

first year the technology is available

FC-Lower:

low-end estimate of the incremental fuel consumption reduction

FC-Upper:

high-end estimate of the incremental fuel consumption reduction

Cost-Lower:

low-end estimate of the incremental cost (RPE in 2003 dollars, or
dollars/pound for material substitution)

Cost-Upper:

high-end estimate of the incremental cost (RPE in 2003 dollars, or
dollars/pound for material substitution)

Learning Type: whether to apply time-based or volume-based learning to the technology
Learning Threshold: if using volume-based learning, the minimum sales volume the
industry must reach before learning for the technology begins
Learning Rate: the rate of decline to apply to the learning curve (time-based and volumebased)
Aux:

for material substitution technologies, the relative change in curb weight;
not applicable to other technologies

Applicability: whether the technology is available for applicability on a given
technology class
Phase-In:

maximum incremental share of a manufacturer’s fleet to which
technology can be added in model years 2011 to 2015; the phase-in value
for each year is cumulative over the entire analysis period

The technologies are organized into technology types specified by TechType field in the
fourth column. Each technology type is populated with specific technologies following the
sequence specified by the Index column. The sequence of engine and transmission
technologies may be split to follow slightly different paths, based on the original vehicle,
engine, or transmission characteristics, or depending on which technologies have already
been applied to a vehicle. If the original vehicle uses a manual transmission with fewer
than six gears, the only available technology would be the 6-speed manual transmission. If
the original vehicle, however, uses an automatic transmission, the technologies applied
would follow one of the two specified orders: IATC and CVT; or: IATC, 6/7/8-speed auto, and
dual clutch / automatic manual transmission (DCTAM).
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Technology Synergies

Technology synergies occur when the combined effect of two technologies is greater than (or less than) the
given cost or fuel consumption reduction for the two technologies combined. To support synergies, the
technology input file has synergy sections for cost and fuel improvements. Samples from the synergy tables
are shown in Table 15 and

Table 16, below.
The synergy table is most commonly used for synergistic interactions in vehicle
technologies from differing technology groups (e.g. between engine technologies and
transmission technologies). Synergies within a technology group are already built into the
cost and fuel reduction values for the technologies. Therefore, in-group synergies are not
likely to occur, unless special circumstances arise, such as branching of technology paths.
Synergy factors for such circumstances are referred to as “accounting” synergies (see “Type”
column below), and more common technology synergies are referred to as “physical”
synergies.
Table 15. Technology Fuel Consumption Synergy Table

Table 16. Technology Cost Synergy Table
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The purpose of each column in the synergy table is as follows:

Technology A:

defines one of the technologies involved

Technology B:

defines the second technology involved

Subcompact PC: contains values to offset the technology fuel consumption or cost when
either technology A or B is being applied when the other is already
installed

Other Technology Classes: same as above
When a technology is being applied (or is being tested for application), a lookup is
performed in the ‘Technology A’ and ‘Technology B’ columns of the table. If found, the
paired vehicle is examined to determine if the paired technology (or technologies) have been
applied (or are installed as part of the base vehicle definition). If so, the offset value for the
applicable vehicle class is obtained, summed, and applied to the cost or fuel consumption
reduction of the technology being examined.
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Appendix D.5

Scenario Definition

Worksheets that begin with “SCEN_” are identified as CAFE program scenarios, which are
defined in terms of the design and stringency of the CAFE program. The system numbers
these scenarios 0,1,2,... based on their order of appearance. Scenario 0 (Scen0) is identified
as the baseline scenario to which all others are compared. Each scenario defines the CAFE
program as it relates to the following “regulatory classes”:
Table 17. Regulatory Classes

Reg. Class

Includes

0

unregulated vehicles

1

passenger automobiles (domestic)

2

passenger automobiles (imported)

3

nonpassenger automobiles

Under the current system, all nonpassenger automobiles with GVW ratings below 8,500
pounds will be assigned to use regulatory class 3. By default, regulatory class 0 includes
vehicles with GVW ratings above 8,500 pounds. However, as discussed below, such vehicles
can be selectively assigned to use the nonpassenger automobile regulatory class.
Table 18 shows an example of a CAFE scenario definition worksheet. The purpose of each of
the defined sections is as follows:

Scenario Description: a short name describing the key features of the scenario
Regulatory Reclassification: specifies whether vehicles from one regulatory class should be merged with
vehicles from another regulatory class.

Table 19 describes all available merging options. In the example scenario shown in Table
18, “RC1A” code indicates that all vehicles should be merged into the domestic passenger
automobiles, regulatory class 1.
Passenger Automobile Standards: the CAFE functional or flat standards to use during
modeling of the scenario. The appropriate “Fnc Type” is indicated by entering the
corresponding code from Table 20. For example, entering “1” directs the compliance
simulation model to apply a flat standard system, whereas entering “2” directs the model to
use a logistic area-based functional form. The “Coefficients” sub-section contains
corresponding coefficient values. Lastly, the “Alt. Minimum” sub-section applies non-flat
standard scenarios and represents the alternative minimum CAFE standards to apply to
manufacturers whose required functional CAFE standard is below a specific minimum
(mpg), or less than the specific percentage of the industry average (% average). In the
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example scenario in,Table 18 function type “2” is used, indicating that passenger
automobiles should use a logistic area-based functional form standard system, with the
coefficients specified in fields A through D.

Nonpassenger Automobile Standards: same as the Passenger Automobile Standards
section above, but applies to nonpassenger automobiles. The example scenario below
does not provide a standards definition for use with nonpassenger automobiles, since the
regulatory declassification section forces all vehicles into RC-1.
Comply By Industry: “Y” forces the model to treat the entire industry as one
manufacturer and perform compliance simulation on all manufacturers at the same time;
N or blank is the default and performs compliance simulation on each manufacturer
individually.
Table 18. Scenario Definition Worksheet (Sample)
CAFE Scenario Definition

Model Year
optimized standards

Scenario Description

2011 2012 2013 2014 2015
RC1A RC1A RC1A RC1A RC1A

Regulatory Declassification

Passenger
Automobile Standards

Fnc Type

2011
2

2012
2

2013
2

2014
2

2015
2

Coefficients
A
B
C
D

34.9
30.7
42.3
2.0

34.2
30.6
43.7
2.1

34.1
31.0
43.1
1.6

34.5
31.3
43.3
2.0

35.9
31.7
42.5
1.0

Alt. Minimum
mpg
% average

27.5
92%

27.5
92%

27.5
92%

27.5
92%

27.5
92%

2011

2012

2013

2014

2015

2011

2012

2013

2014

2015

Fnc Type

Nonpassenger
Automobile Standards

Coefficients
A
B
C
D
Alt. Minimum
mpg
% average

Comply By Industry

Table 19. Regulatory Reclassifications
Code

Description
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<blank>
RC1
RC1A
RC3

do not apply regulatory merging to any classes
if all passenger automobiles (domestic and imported) should be
merged into regulatory class 1
if all vehicles (passenger, nonpassenger, and unregulated
automobiles) should be merged into regulatory class 1
if all passenger automobiles (domestic and imported) should be
merged into regulatory class 3

RC3D

if all domestic passenger automobiles should be merged into
regulatory class 3

RC3I

if all imported passenger automobiles should be merged into
regulatory class 3

RC3H

if all unregulated vehicles should be merged into regulatory class 3
Table 20. Functional CAFE Standard Specifications

Type
Description
1 Flat standard
A: mpg
2 Logistic area-based function
A: mpg ("ceiling")
B: mpg ("floor")
C: square feet ("midpoint")
D: square feet ("width")

3

Exponential area-based function
A: mpg ("ceiling")
B: mpg (should be >A)
C: sq. ft. (determines "height")

Specification

STDMY  A

STDMY 

 SALES

i , MY

i




 AREAi , MY  C    


 exp 
  
D
1 1 1
i  SALESi,MY   A   B  A     AREAi,MY  C   


 1  exp 
   

D

  




 SALES

STDMY 

i , MY

i



  SALES


i

i , MY

1 1
 AREAi ,MY   
   exp 1 
 
A
B
C

  


note: if AREAmin is the lowest
possible area, C must not exceed
AREAmin/(1-ln(B/A))
4

5

Logistic weight-based function
A: mpg ("ceiling")
B: mpg ("floor")
C: pounds ("midpoint")
D: pounds ("width')

Exponential weight-based function
A: mpg ("ceiling")
B: mpg (should be >A)
C: pounds (determines "height")

STDMY 

 SALES

i , MY

i




 CWi ,MY  C    


 exp 
  
D

  
 SALES   1   1  1  
i 
i , MY
 A  B A  
 CWi , MY  C    


 1  exp 
   

D

  




STDMY 

 SALES

i , MY

i



  SALES
i



i , MY

1 1
 CWi , MY
   exp 1 
C

A B

 
  
 

note: if CWmin is the lowest possible weight, C must not exceed
CWmin/(1-ln(B/A))

NOTE: Automated curve fitting and optimization only available for function type 2.
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Appendix D.6

Parameters

The benefits model parameters file contains a variety of input data and assumptions used
to estimate various impacts of the simulated response of the industry to CAFE standards.
The file contains a series of worksheets, the contents of which are summarized below.
Appendix D.6.1

Vehicle Age Data

The “Vehicle Age Data” worksheet contains age-specific (i.e., vintage-specific) estimates of
the survival rate and annual accumulated mileage applicable to different vehicle categories.
Table 21. Vehicle Age Data

Vehicle
Age Data

Category Model Characteristic

Units

Definition/Notes

Proportion of Original Sales Surviving
proportion
to Age

Proportion of original vehicle sales that remain in service
by vehicle age (year 1 to 26 for cars, 1 - 36 for trucks)

Segment-Based Average Annual
Miles Driven

Average annual miles driven by surviving vehicles by
vehicle age (year 1 to 26 for cars, 1 - 36 for trucks)

miles

Separate survival fractions are used for automobiles and light trucks. These measure the
proportion of vehicles originally produced during a model year that remain in service at
each age (up to 25 years for automobiles and 35 years for light trucks), by which time only a
small fraction typically remain in service.
Appendix D.6.2

Forecast Data

The “Forecast Data” worksheet contains estimates of future fuel prices, which are used
when calculating pre-tax fuel outlays and fuel tax revenues. It also contains the share of
Ethanol-85 to Gasoline fuel, projected for each calendar year.

Table 22. Forecast Data

Forecast Data

Category Model Characteristic

Units

Retail Fuel Prices

$/gallon

Fuel Taxes

$/gallon

Pre-Tax Fuel Price

$/gallon

E85 Share

percent

Definition/Notes
2007 $ per gallon, varies by fuel type, forecast by
calendar year staring with MY-2000
2007 $ per gallon, varies by fuel type, forecast by
calendar year staring with MY-2000
2007 $ per gallon, varies by fuel type, forecast by
calendar year staring with MY-2000
percent share of Ethanol-85 vs. Gasoline fuel used during
each calendar year; varies by fuel type, forecast by
calendar year staring with MY-2000
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Appendix D.6.3

Economic Values

The “Economic Values” worksheet contains an estimate of the magnitude of the “rebound
effect”, as well as the rates used to compute the economic value of various direct and
indirect impacts of CAFE standards, and the discount rate to apply when calculating
present value. As mentioned above, the user can define and edit all inputs. For example,
although Table 23 identifies available sources of information for economic values, the
system does not require that the user rely on these sources.
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Table 23. Economic Values
Category Model Characteristic
Rebound Effect

percent

Discount Rate

percent

Payback Period

integer

Kf
"Gap" between Test and On-Road
MPG

Definition/Notes
increase in the annual use of vehicle models in response to
lower per-mile cost of driving a more fuel-efficient
vehicle
percent rate by which the dollar value of a benefit or cost
is reduced when its receipt or payment is postponed by
one additional year into the future
number of years required for an initial investment to be
repaid in the form of future benefits or cost savings

$/mpg

the CAFE fine rate
difference between a vehicle's EPA fuel economy rating
and its actual on-road fuel economy
amount that the driver of a vehicle would be willing to pay
to reduce the time required to make a trip
economic costs of various oil imports

percent

Value of Travel Time per Vehicle

$/hour

Economic Costs of Oil Imports

various

"Monopsony" Component

Economic Values

Units

demand cost for imported oil; increasing domestic
petroleum demand that is met through higher oil imports
can cause the world price of oil to rise, and conversely
that declining imports can reduce the world price of oil;
determined by a complex set of factors, including the
relative importance of U.S. imports in the world oil
market and demand to its world price among other
participants in the international oil market

$/gallon

expected value of costs to U.S. economy from reduction
in potential output resulting from risk of significant
increases in world petroleum price; includes costs
resulting from inefficiencies in resource use caused by
incomplete adjustments to industry output levels and
mixes of production input when world oil price changes
rapidly
costs of taxpayers for maintaining a military presence to
secure the supply of oil imports from potentially unstable
regions of the world and protect the nation against their
interruption

Price Shock Component

$/gallon

Military Security Component

$/gallon

Total Economic Costs ($/gallon)

$/gallon

total economic costs of oil imports (sum of monopsony,
price shock, and military security components)

Total Economic Costs ($/BBL)

$/BBL

total economic costs of oil imports, specified in $/BBL

various

estimates intended to represent costs per vehicle-mile of
increased travel compared to approximately current
levels, assuming current distribution of travel by hours of
the day and facility types
congestion component of external costs from additional
vehicle use
accidents component of external costs from additional
vehicle use
noise component of external costs from additional vehicle
use
additional costs arising from emission damage

Carbon Monoxide

$/ton

economic costs arising from Carbon Monoxide damage

Volatile Organic Compounds

$/ton

Nitrogen Oxides

$/ton

External Costs from Additional
Vehicle Use Due
to "Rebound" Effect

$/vehicle-mile

Congestion

$/vehicle-mile

Accidents

$/vehicle-mile

Noise

$/vehicle-mile

Emission Damage Costs

economic costs arising from Volatile Organic Compounds
damage
economic costs arising from Nitrous Oxides damage

Particulate Matter

$/ton

economic costs arising from Particulate Matter damage

Sulfur Dioxide
Carbon Dioxide

$/ton
$/metric ton

economic costs arising from Sulfur Oxides damage
economic costs arising from Carbon Dioxide damage
percent of annual increase in economic costs arising from
Carbon Dioxide damage
the reference year, which the economic costs arising from
Carbon Dioxide damage are specified in

CO-2 Annual Cost Increase

percent

CO-2 Reference Year

model year
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By reducing the cost of gasoline per mile driven, tighter CAFE standards can result in a
slight increase in annual miles driven per vehicle. This increase in the annual number of
miles each vehicle is driven, referred to as the “rebound effect,” also produces a
corresponding increase in the total number of miles driven by vehicles of each model year
during each calendar year they remain in the fleet. The magnitude of the rebound effect
from higher fuel economy standards is equal to the negative of the elasticity of vehicle use
(measured either per vehicle or for an entire vehicle fleet) with respect to either fuel cost
per mile driven (equal to fuel price per gallon divided by miles per gallon) or fuel efficiency
itself. (This elasticity has a negative value, so the rebound effect is expressed as a positive
value.)
Importing petroleum into the United States is widely believed to impose significant costs on
households and businesses that are not reflected in the market price for imported oil, and
thus are not borne by consumers of refined petroleum products. These costs include three
components: (1) higher costs for oil imports resulting from the combined effect of U.S.
import demand and OPEC market power on the world oil price; (2) the risk of reductions in
U.S. economic output and disruption of the domestic economy caused by sudden reductions
in the supply of imported oil; and (3) costs for maintaining a U.S. military presence to
secure imported oil supplies from unstable regions, and for maintaining the Strategic
Petroleum Reserve (SPR) to cushion against price increases. By reducing domestic demand
for gasoline, tighter CAFE standards may reduce petroleum imports, thus lowering some or
all of these external or social costs to the U.S. economy from importing oil.
Appendix D.6.4

Fuel Properties

The “Fuel Properties” worksheet contains estimates of the physical properties of gasoline,
diesel, and other types of fuels, as well as certain assumptions about the effects of reduced
fuel use on different sources of petroleum feedstocks and on imports of refined fuels. These
fuel properties and assumptions about the response of petroleum markets to reduced fuel
use are used to calculate the changes in vehicular carbon dioxide emissions as well as in
“upstream” emissions (from petroleum extraction and refining and from fuel storage and
distribution) that are likely to result from reduced motor fuel use.
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Table 24. Fuel Properties
Category Model Characteristic

Units

Energy Density

BTU/gallon

Mass Density

grams/gallon
percent by
weight

Fuel Properties

Carbon Content
Share of Fuel Savings Leading to
Lower Fuel Imports
Share of Fuel Savings Leading to
Reduced Domestic Fuel Refining
Share of Reduced Domestic
Refining from Domestic Crude
Share of Reduced Domestic
Refining from Imported Crude

Appendix D.6.5

average share of carbon in fuel, specified by fuel type
assumed value for share of fuel savings leading to lower
fuel imports
assumed value for share of fuel savings leading to reduced
domestic fuel refining
assumed value for share of reduced domestic refining
from domestic crude
assumed value for share of reduced domestic refining
from imported crude

percent
percent
percent
percent

Assumed Gasoline Mix

Definition/Notes
amount of energy stored in a given system or region of
space per unit volume, specified by fuel type
mass per unit volume, specified by fuel type

percent

estimated share of total fuel consumption by fuel type

Upstream Emissions

The “Upstream Emissions” worksheet contains emission factors for greenhouse gas and
criteria pollutant emissions from petroleum extraction and transportation, and from fuel
refining, storage, and distribution.
Table 25. Upstream Emissions

Upstream Emissions
(Total Emissions by Stage of Fuel
Production and Distribution)

Category Model Characteristic

Units

Petroleum Extraction

grams/mil BTU

Petroleum Transportation

grams/mil BTU

Petroleum Refining

grams/mil BTU

Fuel TS&D

grams/mil BTU
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Definition/Notes
total emissions by stage of fuel production and
distribution from petroleum extraction, specified by
pollutant and fuel type
total emissions by stage of fuel production and
distribution from petroleum transportation, specified by
pollutant and fuel type
total emissions by stage of fuel production and
distribution from petroleum refining, specified by
pollutant and fuel type
total emissions by stage of fuel production and
distribution from refined fuel transportation, storage, and
delivery, specified by pollutant and fuel type
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Appendix D.7

Emissions Rates

The emissions rates file contains vehicular criteria pollutant emission factors. Emission
factors (all in grams per mile and specific to both vehicle model year and age) for all fuel
types (gasoline, reformulated gasoline, and Diesel, E85, CFG, Hydrogen, and two spares)
and five pollutants (CO, VOC, NOX, PM2.5, and SO2) are contained in a series of forty
worksheets of identical structure.
Table 26. Vehicular Emission Factors (CO shown for gasoline and diesel only)

CO Rates - Diesel

CO Rates - RFG Gas

CO Rates - Gas

Category

Model Characteristic

Units

Definition/Notes
Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGV class
for conventional gasoline

CO LDGV

grams/mile

CO LDGT12

grams/mile

Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGT1 and
LDGT2 classes for conventional gasoline

CO LDGT34

grams/mile

Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGT3 and
LDGT4 classes for conventional gasoline

CO HDGV2b

grams/mile

CO LDGV

grams/mile

CO LDGT12

grams/mile

CO LDGT34

grams/mile

CO HDGV2b

grams/mile

CO LDDV

grams/mile

CO LDDT12

grams/mile

CO LDDT34

grams/mile

CO HDDV2b

grams/mile

Carbon monoxide vehicle operation
emission rate for MOBILE6 HDGV2b class
for conventional gasoline
Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGV class
for refined gasoline
Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGT1 and
LDGT2 classes for refined gasoline
Carbon monoxide vehicle operation
emission rate for MOBILE6 LDGT3 and
LDGT4 classes for refined gasoline
Carbon monoxide vehicle operation
emission rate for MOBILE6 HDGV2b class
for refined gasoline
Carbon monoxide vehicle operation
emission rate for MOBILE6 LDDV class
for diesel
NO VALUE - NO VEHICLES IN THIS
CLASS
Carbon monoxide emission rate for
MOBILE6 class LDDT34 for diesel
Carbon monoxide vehicle operation
emission rate for MOBILE6 HDDV2b class
for diesel

Source

U.S. Environmental Protection Agency, MOBILE Motor Vehicle Emission Factor
Model, version 6.1/6.2, October 2004.

U.S. Environmental Protection Agency, MOBILE Motor Vehicle Emission Factor
Model, version 6.1/6.2, October 2004.

U.S. Environmental Protection Agency, MOBILE Motor Vehicle Emission Factor
Model, version 6.1/6.2, October 2004.

Covered pollutants include carbon monoxide (CO), volatile organic compounds (VOC),
nitrogen oxides (NOX), sulfur dioxide (SO2), and fine particulate matter (PM2.5, or
particulate matter less than 2.5 microns in diameter). Particulate matter includes sulfate
particulates, elemental carbon, non-volatile organic carbon compounds, and airborne lead,
as well as particulate emissions from brake and tire wear. Because we are concerned with
increased emissions from more intensive use of existing vehicles (rather than from a larger
vehicle fleet), the emission factors we estimated included only the components associated
with vehicle use, and omitted those associated with vehicle storage. Emission components
associated with increased vehicle use include exhaust emissions during vehicle start-up and
operation, evaporative emissions during vehicle operation, cool-down (“hot soak”), and
refueling, and particulate emissions from brake and tire wear.
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Appendix E.1

Outputs
Overview

The system produces six formatted output files, all as Microsoft Excel workbooks, four of
which are for each scenario defined in the compliance model scenarios file, and two
cumulative output files covering all scenarios. The system places all files in the “reports”
folder, located in the user selected output path, under the session name (ex: C:\cafe\demo
run\demo\reports). Table 27 lists the available output files and their contents. As
discussed earlier, the first scenario appearing in the scenarios file is assigned to Scenario 0
and treated as the baseline scenario. Output files for all other scenarios report absolute and
relative changes compared to this baseline.26
Output File27

Table 27 Output File Contents
Contents

Industry_Summary_Sn*.xls

industry-wide and manufacturer-specific results, showing all model years per
worksheet, for each regulatory class:28 sales; preliminary and final value of
CAFE standard; average fuel economy, curb weight, area, incurred technology
cost, incurred fine, price increase; total technology costs, fines, and increases in
sales revenue; technology application and penetration rates

Manufacturer_Summary_Sn*.xls

industry-wide and manufacturer-specific results, showing one model year per
worksheet, for each regulatory class: sales; preliminary and final value of CAFE
standard; average fuel economy, curb weight, area, incurred technology cost,
incurred fine, price increase; total technology costs, fines, and increases in sales
revenue; technology application and penetration rates

Vehicles_Summary_Sn*.xls

vehicle model-specific results: index, ID number, manufacturer, model name,
nameplate, regulatory class, NRC class, predecessor ID number, initial and final
sales, initial MSRP and price, initial and final fuel economy and curb weight,
area, engine ID number and basic characteristics, transmission ID number and
type, unit and total technology cost and price increase, redesign and refresh
states, application and usage status of each technology

Effects_Summary_Sn*.xls
national-scale effects: travel demand, fuel consumption, carbon dioxide and
criteria pollutant emissions, and economic externalities related to highway travel

26

For example, if the baseline scenario involves a flat 27.5 mpg standard for passenger automobiles and Scenario 3
examines a reformed standard with a higher average required value of CAFE standard, Industry_Summary_Sn3.xls
might report total technology costs of $2.2b, of which about $2.0b might be attributable to the increase in the overall
standard.

27

Here, the asterisk (*) indicates a number corresponding to a scenario, with 0 indicating the baseline scenario.

28

As discussed earlier, RC0=unregulated vehicles, RC1=domestic cars, RC2=imported cars, and RC3 =light trucks.
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and petroleum consumption

EA_Report.xls

national-scale effects, for all scenarios, disaggregated by calendar year for each
model year: fuel consumption and carbon dioxide and criteria pollutant
emissions

ScenSummary_Report.xls

summary of industry-wide and manufacturer-specific results, compared versus
the baseline for all scenarios: total costs and benefits (manufacturer and total
cost, fuel savings, preliminary and final value of CAFE standard, total and net
benefits, and benefit-to-cost ratio); price increase

The remainder of this section shows sample output files for a scenario based on reformed
passenger automobile standards, with a 27.5 mpg flat standard in the baseline scenario.
Both scenarios address model years spawning five years (2011-2015), however, only the
first and the last years (2011 and 2015) are displayed in most screenshots. Also, both
scenarios assume regulatory merging of all vehicles into RC-1 (domestic passenger autos).
Furthermore, because the output files produced by the system are extensive, the text shows
only portions of some files. Also, although the system produces output specific to each
represented vehicle model, only the more summarized output files are shown here.
The file defining the initial state of the fleet for this example—demo_market_data.xls—
contains fictitious entries for many fields. Therefore, when used with this file, the system
will produce fictitious results. Though useful for diagnostic purposes, such results should be
treated as otherwise meaningless.
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Appendix E.2

Industry-Level Summary
Table 28. Industry-Level Summary (Sample)
2011 Total
Current
Delta
Scenario
(abs.)
0
0
2,253,137
0
0
0
0
0
2,253,137
0
0.00
0.00
31.72
4.22
0.00
0.00
0.00
0.00
31.72
4.22
0.00
0.00
31.72
4.22
0.00
0.00
0.00
0.00
31.72
4.22
0.00
0.00
30.62
2.40
0.00
0.00
0.00
0.00
30.62
2.40
0
0
3,332
0
0
0
0
0
3,332
0
0
0
46
0
0
0
0
0
46
0
$
$
$ 897.49 $ 751.56
$
$
$
$
$ 897.49 $ 751.56
$
$
$
60.83 $
60.83
$
$
$
$
$
60.83 $
60.83
$
$
$ 958.32 $ 812.39
$
$
$
$
$ 958.32 $ 812.39
$
$
$ 2,022.16 $ 1,693.36
$
$
$
$
$ 2,022.16 $ 1,693.36
$
$
$ 137.07 $ 137.07
$
$
$
$
$ 137.07 $ 137.07
$
$
$ 2,159.23 $ 1,830.43
$
$
$
$
$ 2,159.23 $ 1,830.43

Industry Overall

Total Sales

Value of Preliminary CAFE Standard

Value of Final CAFE Standard

Average Fuel Economy

Average Curb Weight (lb.)

Average Area (sq. ft.)

Average Technology Costs (RPE)

Average Fines Incurred (RPE)

Average Price Increase Per Vehicle
(Including Tech Costs and Fines)

Total Incurred Technology Costs ($m)

Total Fines Owed ($m)

Total Increase in Sales Revenue ($m)

Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
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Delta
(%)
-%
-%
-%
-%
-%
-%
15%
-%
-%
15%
-%
15%
-%
-%
15%
-%
8%
-%
-%
8%
-%
-%
-%
-%
-%
-%
-%
-%
-%
-%
-%
515%
-%
-%
515%
-%
-%
-%
-%
-%
-%
557%
-%
-%
557%
-%
515%
-%
-%
515%
-%
-%
-%
-%
-%
-%
557%
-%
-%
557%

2015 Total
Current
Delta
Scenario
(abs.)
0
0
2,253,137
0
0
0
0
0
2,253,137
0
0.00
0.00
32.72
5.22
0.00
0.00
0.00
0.00
32.72
5.22
0.00
0.00
32.72
5.22
0.00
0.00
0.00
0.00
32.72
5.22
0.00
0.00
32.72
4.49
0.00
0.00
0.00
0.00
32.72
4.49
0
0
3,332
0
0
0
0
0
3,332
0
0
0
46
0
0
0
0
0
46
0
$
$
$ 1,423.45 $ 1,277.52
$
$
$
$
$ 1,423.45 $ 1,277.52
$
$
$
$
$
$
$
$
$
$
$
$
$ 1,423.45 $ 1,277.52
$
$
$
$
$ 1,423.45 $ 1,277.52
$
$
$ 3,207.23 $ 2,878.44
$
$
$
$
$ 3,207.23 $ 2,878.44
$
$
$
$
$
$
$
$
$
$
$
$
$ 3,207.23 $ 2,878.44
$
$
$
$
$ 3,207.23 $ 2,878.44

Delta
(%)
-%
-%
-%
-%
-%
-%
19%
-%
-%
19%
-%
19%
-%
-%
19%
-%
16%
-%
-%
16%
-%
-%
-%
-%
-%
-%
-%
-%
-%
-%
-%
875%
-%
-%
875%
-%
-%
-%
-%
-%
-%
875%
-%
-%
875%
-%
875%
-%
-%
875%
-%
-%
-%
-%
-%
-%
875%
-%
-%
875%
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Manufacturer-Level Summary
Table 29. Manufacturer-Level Summary (Sample)
Manufacturer

Total Sales

Value of Preliminary CAFE Standard

Value of Final CAFE Standard

Average Fuel Economy

Average Curb Weight (lb.)

Average Area (sq. ft.)

Average Technology Costs (RPE)

Average Fines Incurred (RPE)

Average Price Increase Per Vehicle
(Including Tech Costs and Fines)

Total Incurred Technology Costs ($m)

Total Fines Owed ($m)

Total Increase in Sales Revenue ($m)

Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
Unregulated
Dom Auto
Imp Auto
Light Truck
Overall
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Current
Scenario
0
272,571
0
0
272,571
0.00
30.20
0.00
0.00
30.20
0.00
30.20
0.00
0.00
30.20
0.00
28.85
0.00
0.00
28.85
0
3,512
0
0
3,512
0
45
0
0
45
$
$ 377.76
$
$
$ 377.76
$
$ 71.50
$
$
$ 71.50
$
$ 449.26
$
$
$ 449.26
$
$ 102.97
$
$
$ 102.97
$
$ 19.49
$
$
$ 19.49
$
$ 122.46
$
$
$ 122.46

BMW
Chrysler
Delta Delta Current Delta Delta
(abs.)
(%) Scenario (abs.)
(%)
0
-%
0
0
-%
0
-%
193,703
0
-%
0
-%
0
0
-%
0
-%
0
0
-%
0
-%
193,703
0
-%
0.00
-%
0.00
0.00
-%
0.00
-%
29.60
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
29.60
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
29.60
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
29.60
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
28.39
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
0.00
0.00
-%
0.00
-%
28.39
0.00
-%
0
-%
0
0
-%
0
-%
3,498
0
-%
0
-%
0
0
-%
0
-%
0
0
-%
0
-%
3,498
0
-%
0
-%
0
0
-%
0
-%
46
0
-%
0
-%
0
0
-%
0
-%
0
0
-%
0
-%
46
0
-%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
$ -% $
$ -%
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Appendix F

Vehicle-Level Summary
Table 30. Vehicle-Level Summary Contents

Group

Column
Index
ID#
Manufacturer
Model
Name Plate
Reg Class
Technology Class
Pred ID#
Initial
Total Sales
Final
Initial MSRP ($)
Initial Price ($)
Initial
Fuel Econ. (mpg)
Final
Initial
Curb Weight (lb)
Final
Area (sf)
ID#
Fuel
Engine
Disp (lit.)
Cyl.
ID#
Transmission
Type
Incurred Tech Cost
Unit ($)
Price Increase
Incurred Tech Cost
Total ($k)
Increase in Sales Rev.
Redesign State
Refresh State
Technology Utilization/Applicability

Contents
unique vehicle index for the entire industry
unique vehicle ID per manufacturer
manufacturer name
model name
nameplate name
regulatory class
vehicle technology class
ID number of the vehicle's predecessor
initial sales volume (units)
final sales volume (units)
initial MSRP ($)
final MSRP ($)
initial fuel economy
final fuel economy
initial curb weight
final curb weight
vehicle footprint
ID number of the vehicle's engine
engine fuel type
engine displacement
number of cylinders
ID number of the vehicle's transmission
transmission type
unit technology cost ($)
unit price increase ($)
total technology cost ($)
total increase in revenue ($)
redesign state of the vehicle
refresh state of the vehicle
usage of each technology by the vehicle
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Appendix F.1

Effects Summary

The summary of effects for each scenario is organized into sections. The first section, shown
by example in,Table 31 presents calculated levels of fuel consumed (in thousands of gallons)
during the full useful life of all vehicles sold in each model year. Calculated sales volumes,
full useful life travel, and average fuel economy levels are also presented to provide a basis
for comparison. However, because the system calculates lifetime travel (taking into account
the rebound effect) and fuel consumption on a model-by-model basis, these additional
aggregate calculations are only generally explanatory, and cannot be used to calculate
lifetime fuel consumption.
Table 31. Effects Summary—Energy Consumption
Model Year

2011 Total
Delta
(abs.)

Current
Scenario

Delta
(%)

Current
Scenario

2015 Total
Delta
(abs.)

Delta
(%)

Energy Consumption
Lifetime Fuel Consumption (k gal.)

Sales

Lifetime VMT (k mi.)

Average Fuel Economy (mpg)

Gas
Diesel
Total
Gas
Diesel
Total
Gas
Diesel
Total
Gas
Diesel
Total

14,277,270
373,542
14,650,812
2,190,626
62,512
2,253,137
348,808,204
10,160,775
358,968,979
30.53
33.99
30.62

-1,444,637
(9%) 13,116,480 -2,605,427
(17%)
373,542
-%
714,217
714,217
-%
-1,071,095
(7%) 13,830,697 -1,891,210
(12%)
-62,512
(3%)
2,124,056
-129,082
(6%)
62,512
-%
129,082
129,082
-%
0
-%
2,253,137
0
-%
-6,064,678
(2%) 340,974,545 -13,898,336
(4%)
10,160,775
- % 21,097,484 21,097,484
-%
4,096,097
1% 362,072,029 7,199,148
2%
2.32
8%
32.50
4.29
15%
65,535.00 6553500%
36.90 65,535.00 6553500%
2.41
9%
32.72
4.51
16%

The second section presents estimates of full fuel cycle carbon dioxide and criteria pollutant
emissions, reporting results for the following emissions classes represented in EPA’s
MOBILE6 emissions model:
Emissions Class

Table 32. MOBILE6 Emissions Classes
Definition

LDDV

Diesel cars

LDGV

gasoline cars

LDDT1

Diesel trucks with GVW ratings below 6,000 pounds

LDGT1

gasoline trucks with GVW ratings below 6,000 pounds

LDDT2

Diesel trucks with GVW ratings between 6,000 and 8,500 pounds

LDGT2

gasoline trucks with GVW ratings between 6,000 and 8,500 pounds

HDDV2b

Diesel trucks with GVW ratings between 8,500 and 10,000 pounds

HDGV2b

gasoline trucks with GVW ratings between 8,500 and 10,000 pounds

Table 33 shows sample emissions calculations. As indicated, carbon dioxide emissions are
reported in thousand metric tons of carbon-equivalent emissions (one metric ton of carbon
dioxide is equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are
reported in short tons (one ton equals 2,000 pounds).
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Table 33. Effects Summary—Emissions
Model Year

2011 Total
Delta
(abs.)

Current
Scenario

Delta
(%)

Current
Scenario

2015 Total
Delta
(abs.)

Delta
(%)

Emissions

CO2 (mmT)

CO (tons)

VOC (tons)

NOX (tons)

PM (tons)

SOX (tons)

LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total
LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total
LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total
LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total
LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total
LDGV
LDDV
LDGT1
LDDT1
LDGT2
LDDT2
HDGV2b
HDDV2b
Total

138
4
0
0
0
0
0
0
142
5,979,374
6,833
0
0
0
0
0
0
5,986,206
150,758
740
0
0
0
0
0
0
151,498
127,476
1,312
0
0
0
0
0
0
128,787
7,385
245
0
0
0
0
0
0
7,629
21,642
547
0
0
0
0
0
0
22,190
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-14
4
0
0
0
0
0
0
-10
-104,775
6,833
0
0
0
0
0
0
-97,942
-6,058
740
0
0
0
0
0
0
-5,318
-5,136
1,312
0
0
0
0
0
0
-3,824
-377
245
0
0
0
0
0
0
-133
-1,971
547
0
0
0
0
0
0
-1,424

(9%)
-%
-%
-%
-%
-%
-%
-%
(6%)
(2%)
-%
-%
-%
-%
-%
-%
-%
(2%)
(4%)
-%
-%
-%
-%
-%
-%
-%
(3%)
(4%)
-%
-%
-%
-%
-%
-%
-%
(3%)
(5%)
-%
-%
-%
-%
-%
-%
-%
(2%)
(8%)
-%
-%
-%
-%
-%
-%
-%
(6%)

127
8
0
0
0
0
0
0
135
5,774,582
14,038
0
0
0
0
0
0
5,788,620
139,759
1,491
0
0
0
0
0
0
141,250
119,905
2,558
0
0
0
0
0
0
122,463
7,017
450
0
0
0
0
0
0
7,467
20,036
1,051
0
0
0
0
0
0
21,087

-25
8
0
0
0
0
0
0
-17
-236,781
14,038
0
0
0
0
0
0
-222,743
-11,645
1,491
0
0
0
0
0
0
-10,153
-9,940
2,558
0
0
0
0
0
0
-7,383
-717
450
0
0
0
0
0
0
-267
-3,578
1,051
0
0
0
0
0
0
-2,527

(17%)
-%
-%
-%
-%
-%
-%
-%
(11%)
(4%)
-%
-%
-%
-%
-%
-%
-%
(4%)
(8%)
-%
-%
-%
-%
-%
-%
-%
(7%)
(8%)
-%
-%
-%
-%
-%
-%
-%
(6%)
(9%)
-%
-%
-%
-%
-%
-%
-%
(3%)
(15%)
-%
-%
-%
-%
-%
-%
-%
(11%)
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The third and fourth sections of the effects summary presents monetized private and social
costs and benefits of each scenario. These effects, discussed in detail in Section III.C.6 of
the primary text, include the following:

Pretax Fuel Expenditures: savings in pretax cost to vehicle users of vehicle fuel
Fuel Tax Revenues: reduction in total (federal and state) fuel tax revenues
Travel Value: the value derived from additional driving due to the “rebound efffect”
Refueling Time Value: savings in the value of vehicle occupants’ time during refueling
Petroleum Market Externalities: reduction in costs of economic externalities resulting
from crude petroleum imports
Congestion Costs: the additional cost of highway congestion from added driving due to
the “rebound effect”
Accident Costs: additional injury and damage costs of highway crashes
Emissions Damage Costs: the change in damage costs from air pollutant emissions (by
species)
In all cases, these costs and benefits are calculated for the fleet of vehicles sold in each
model year over their full useful lives, discounted using the rate specified in the benefits
model parameters file, and reported in thousands of constant year-2003 dollars.29 Section
III.C.6 of the primary text discusses these types of costs and benefits in greater detail, and
Appendix C (Benefits Model Parameters) discusses corresponding input assumptions.

29

Undiscounted values of these impacts are also reported.
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Table 34. Effects Summary—Private and Social Costs and Benefits

Model Year

Current
Scenario

2011 Total
Delta
(abs.)

Delta
(%)

Current
Scenario

2015 Total
Delta
(abs.)

Delta
(%)

Undiscounted Owner and Societal Costs (k $)
Total Lifetime Pretax Fuel Expenditures
Fuel Tax Revenues
Travel Value
Refueling Time Value
Petroleum Market Externalities
Congestion Costs
Noise Costs
Accident Costs
CO2
CO
VOC
NOX
PM
SOX

29,238,893 -2,066,464
5,823,180
-431,832
-268,748
-268,748
-119,536
-119,536
5,307,037
-387,988
19,240,737
219,551
251,278
2,867
8,328,080
95,029
445,379
-30,831
0
0
257,547
-9,040
515,149
-15,296
1,281,699
-22,305
355,036
-22,785

(7%)
(7%)
-%
-%
(7%)
1%
1%
1%
(6%)
-%
(3%)
(3%)
(2%)
(6%)

27,654,812
5,324,980
-459,608
-211,763
5,009,962
19,407,061
253,450
8,400,071
540,863
0
240,126
489,851
1,254,481
337,389

-3,625,202
-743,517
-459,608
-211,763
-685,062
385,874
5,039
167,020
-69,468
0
-17,261
-29,531
-44,853
-40,432

(12%)
(12%)
-%
-%
(12%)
2%
2%
2%
(11%)
-%
(7%)
(6%)
(3%)
(11%)

Discounted Owner and Societal Costs (k $)
Total Lifetime Pretax Fuel Expenditures
Fuel Tax Revenues
Travel Value
Refueling Time Value
Petroleum Market Externalities
Congestion Costs
Noise Costs
Accident Costs
CO2
CO
VOC
NOX
PM
SOX

19,879,502 -1,406,137
4,003,180
-296,438
-183,047
-183,047
-81,254
-81,254
3,607,427
-263,733
13,078,777
149,238
170,805
1,949
5,660,963
64,596
274,067
-18,972
0
0
147,016
-5,723
289,832
-9,385
872,817
-14,533
241,334
-15,488

(7%)
(7%)
-%
-%
(7%)
1%
1%
1%
(6%)
-%
(4%)
(3%)
(2%)
(6%)

18,563,719
3,653,405
-309,590
-143,945
3,405,492
13,191,834
172,281
5,709,898
332,823
0
139,333
278,255
857,724
229,338

-2,436,179
-509,371
-309,590
-143,945
-465,667
262,296
3,426
113,531
-42,748
0
-10,891
-17,917
-27,299
-27,483

(12%)
(12%)
-%
-%
(12%)
2%
2%
2%
(11%)
-%
(7%)
(6%)
(3%)
(11%)

87

DRAFT

Appendix F.2

Environmental Assessment Summary
Table 35. Environmental Assessment Summary (Sample)

Fuel Consumption (k. gal) -- Sn 0, Years 2011 - 2015
Calendar Years
Model
Years
2011
2012
2013
2014
2015
2016
2011 1,375,463.85 1,342,592.32 1,305,352.07 1,262,600.58 1,213,996.93 1,159,685.57
1,375,463.85 1,342,592.32 1,305,352.07 1,262,600.58 1,213,996.93
2012
1,375,463.85 1,342,592.32 1,305,352.07 1,262,600.58
2013
1,375,463.85 1,342,592.32 1,305,352.07
2014
1,375,463.85 1,342,592.32
2015
Total 1,375,463.85 2,718,056.17 4,023,408.24 5,286,008.82 6,500,005.75 6,284,227.47
Fuel Consumption (k. gal) -- Sn 1, Years 2011 - 2015
Calendar Years
Model
Years
2011
2012
2013
2014
2015
2016
2011 1,407,216.29 1,373,585.93 1,335,485.98 1,291,747.58 1,242,021.92 1,186,456.79
1,407,216.29 1,373,585.93 1,335,485.98 1,291,747.58 1,242,021.92
2012
1,407,216.29 1,373,585.93 1,335,485.98 1,291,747.58
2013
1,407,216.29 1,373,585.93 1,335,485.98
2014
1,407,216.29 1,373,585.93
2015
Total 1,407,216.29 2,780,802.22 4,116,288.20 5,408,035.78 6,650,057.70 6,429,298.20
Fuel Consumption (k. gal) -- Sn 2, Years 2011 - 2015
Calendar Years
Model
Years
2011
2012
2013
2014
2015
2016
2011 1,281,756.89 1,251,124.82 1,216,421.65 1,176,582.71 1,131,290.31 1,080,679.06
1,260,239.59 1,230,121.75 1,196,001.16 1,156,831.01 1,112,298.95
2012
1,237,292.34 1,207,722.91 1,174,223.60 1,135,766.69
2013
1,222,806.32 1,193,583.08 1,160,475.98
2014
1,210,007.43 1,181,090.06
2015
Total 1,281,756.89 2,511,364.41 3,683,835.75 4,803,113.10 5,865,935.44 5,670,310.74
Fuel Consumption (k. gal) -- Sn 3, Years 2011 - 2015
Calendar Years
Model
Years
2011
2012
2013
2014
2015
2016
2011 1,281,756.89 1,251,124.82 1,216,421.65 1,176,582.71 1,131,290.31 1,080,679.06
1,260,239.59 1,230,121.75 1,196,001.16 1,156,831.01 1,112,298.95
2012
1,241,252.87 1,211,588.78 1,177,982.25 1,139,402.23
2013
1,228,050.99 1,198,702.41 1,165,453.31
2014
1,210,059.80 1,181,141.18
2015
Total 1,281,756.89 2,511,364.41 3,687,796.27 4,812,223.64 5,874,865.78 5,678,974.74
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…

…

…

…

Total
15,721,906.42
15,721,906.42
15,721,906.42
15,721,906.42
15,721,906.42

Total
16,084,844.98
16,084,844.98
16,084,844.98
16,084,844.98
16,084,844.98

Total
14,650,811.71
14,404,863.46
14,142,570.47
13,976,991.53
13,830,696.85

Total
14,650,811.71
14,404,863.46
14,187,840.27
14,036,939.45
13,831,295.48
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Scenario-Level Summary
Table 36. Scenario-Level Summary (Sample)

Manufacturer
BMW
Chrysler
Daimler
Ford
General Motors
Honda
Hyundai
KIA
Mazda
Mitsubishi
Nissan
Porsche
Subaru
Suzuki
Tata
Toyota
Volkswagen
Big-17 Summary
Total
Fuel Savings (BG)
Preliminary Standard (MPG)
Final Standard (MPG)
Total Benefits
Net Benefits
Benefit:Cost Ratio
Entire Industry Summary
Total
Fuel Savings (BG)
Preliminary Standard (MPG)
Final Standard (MPG)
Total Benefits
Net Benefits
Benefit:Cost Ratio

Total Costs ($M) and Benefits
Product Plans (Do-Nothing Standard)
Preferred Alternative
2011 2012 2013 2014 2015 2016 Total 2011 2012 2013 2014 2015
-103 -163 -181 -193 -198 -198 -1,035
0 125
137
167
242
0
-27
-27
-25
-16
-16
-112
0 117
228
249
216
-39
-54
-78 -101 -111 -112
-495
0
0
0
131
211
-26 -237 -266 -265 -263 -255 -1,311
0 2,339 2,448 2,510 2,826
-35 -591 -651 -691 -716 -721 -3,405
0
0 1,596 2,031 2,482
0
0
0
0
0
0
0
0
35
165
306
448
0
0
0
0
0
0
0
0 243
253
362
429
0
0
0
0
0
0
0
0
97
111
128
164
0
0
0
0
0
0
0
0 179
234
327
337
-8
-8
-7
-7
-6
-6
-43
0
71
60
97
109
0
0
0
0
0
0
0
0 626
734 1,239 1,273
0
-26
-43
-45
-41
-41
-196
0
0
-2
-2
-2
0
-33
-29
-27
-26
-25
-140
0
41
43
202
245
-4
-4
-4
-4
-3
-3
-22
0
0
86
118
114
-4
-9
-31
-33
-37
-37
-151
0
2
3
8
15
0
0
0
0
0
0
0
0 226
237
307
544
-105 -126 -143 -143 -142 -143
-802
0
47
202
229
255

2016
355
219
304
3,140
2,827
788
518
227
436
109
1,433
-2
241
130
47
576
434

Total
1,027
1,030
646
13,263
8,935
1,743
1,804
728
1,513
446
5,306
-9
772
447
76
1,890
1,166

-326
-0.688
1.0
1.0
-2,080
-1,754
6.38

-1,277
-1.907
1.0
1.0
-5,945
-4,668
4.66

-1,460
-2.234
1.0
1.0
-7,160
-5,700
4.90

-1,533
-2.355
1.0
1.0
-7,738
-6,205
5.05

-1,559
-2.457
1.0
1.0
-8,251
-6,692
5.29

-1,556 -7,711
0
-2.488 -12.129 0.000
1.0
30.5
1.0
30.5
-8,504 -39,677
0
-6,948 -31,966
0
5.47
5.15 N/A

4,148 6,535 8,409 9,908 11,781 40,781
2.458 5.339 7.481 9.352 11.410 36.040
33.6
34.4
35.2
36.4
38.0
33.6
34.4
35.2
36.4
38.0
7,644 17,047 24,450 31,224 38,730 119,096
3,496 10,513 16,041 21,316 26,949 78,315
1.84
2.61
2.91
3.15
3.29
2.92

-326
-0.688
1.0
1.0
-2,080
-1,754
6.38

-1,277
-1.907
1.0
1.0
-5,945
-4,668
4.66

-1,460
-2.234
1.0
1.0
-7,160
-5,700
4.90

-1,533
-2.355
1.0
1.0
-7,738
-6,205
5.05

-1,559
-2.457
1.0
1.0
-8,251
-6,692
5.29

-1,556 -7,711
0
-2.488 -12.129 0.000
1.0
30.5
1.0
30.5
-8,504 -39,677
0
-6,948 -31,966
0
5.47
5.15 N/A

4,148 6,535 8,409 9,908 11,781 40,781
2.458 5.339 7.481 9.352 11.410 36.040
33.6
34.4
35.2
36.4
38.0
33.6
34.4
35.2
36.4
38.0
7,644 17,047 24,450 31,224 38,730 119,096
3,496 10,513 16,041 21,316 26,949 78,315
1.84
2.61
2.91
3.15
3.29
2.92
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Appendix G

Appendix G.1

Automated Calibration and Optimization of Reformed CAFE Standards

Overview

The CAFE Model contains algorithms that can, given a specified “shape” of an attributebased standard, preserve that shape and find the stringency that satisfies specified criteria.
Also, in the model and this documentation, the term “optimize” is used to refer generically
to estimating the stringency at which a given condition is met. This could include
estimating the stringency at which net societal benefits are maximized, but could also refer
to estimating the stringency at which total costs are equal to total benefits.31 Although the
system defaults to the maximization of net benefits, it provides the ability to perform either
type of “optimization”.
The Optimization Model begins by examining a baseline scenario and aggregating the
baseline costs and benefits for the industry.32 The scenarios file must be set up to contain a
valid reformed functional shape in the “Optimization Definition” scenario (#3), and the
appropriate option selected in the CAFE Model user interface. The Optimization Model has
a set of typical runtime options that define the range for optimization and configure the
basic behavior of the model. The text in the following sections assumes unconstrained
optimization. Also, an example provided in the Operation section described below outlines
a procedure to set up an optimization run using unconstrained optimization, with demo
input data files.

The socially-optimized reformed functional shape is determined for the entire industry, and
for each year, by adjusting the A and B asymptotes (i.e., limits of the constrained linear or
constrained logistic function) at a user-specified increment, for a given number of iterations
above and below the initial calibrated shape. The model years are optimized sequentially, to
ensure the correct “carry-over” of technology costs and improvements. At the end of each
model year, the system re-runs the entire fleet using the optimized reformed shape, then
carries the costs and improvements into the next year. With multi-year planning, earlier
model years are re-run if technologies are applied to facilitate compliance in later model
years.
With the varying A and B asymptotes, the system examines new iterations, performing
typical compliance modeling, holding the functional shape constant while altering the
stringency. At the end of each iteration, the model calculates and saves the final technology
31

If available technologies are exhausted before total costs are equal to total benefits, the system will select the
stringency at which total costs are closest to total benefits.
32

During optimization modeling, even though all of the manufacturers in the industry are examined, only the ones
selected for optimization are considered for costs and benefits calculations. Therefore, during optimization, the term
“entire industry” refers to the set of manufacturers included in the optimization process.
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costs, fines owed, benefits, and fuel savings for each manufacturer and industry overall, as
well as benefit-cost ratios for the entire industry. Once all iterations have been processed,
the modeling system calculates the optimized reformed shape by finding the first iteration
with the maximum net benefits. The last step of the optimization process is to use industryoptimized shape to obtain the optimum fleet for the model year.
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Appendix G.2

Additional Optimization Settings

The above sections provided an overview of optimization modeling, assuming unconstrained
optimization. This section gives a brief overview of two major options available during
optimization.


Optimization Modes ("Optimize using"): When determining the socially-optimized reformed
functional shape for a model year being optimized, the modeling system can be configured to use
the “Maximum Net Benefits (NB)” approach or the “Maximum Technology (Zero NB)”
approach. The former is the default and is described above. The latter is only applicable to
industry-specific optimization and works by first obtaining the iteration where net benefits are
maximized. From there, the system continues to search for more stringent iterations, as long as
the net benefits are above zero (0). As the end result, the optimized functional shape with net
benefits closest to zero is obtained, such that the optimized shape is at the least as stringent as the
shape produced by the “Maximum Net Benefits” approach.



Begin Optimization with the Specified Year: This allow the specification of which year in which
optimization should begin. Use this option when the optimization is to begin in a year other than
the start of the modeling period. Years previous to the specified year will be run through the
compliance model and the resulting fleet will be fed into the optimization model.
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Appendix G.3

Appendix G.3.1

Operation for Running Optimization Scenarios

Create a New Session for Optimization

Step 1: Repeat the procedure for creating a new session as specified in Appendix B.2 –
Appendix C.


When selecting the Compliance Model to use, be sure to select the “CAFE Automated
Optimization Model” option.

Figure 36. Selecting Optimization Model
On the Select Input Files screen, remember to select the scenarios file configured for optimization. Then,
complete the New Session Wizard by entering a session name and clicking the apply button (



Figure 37).
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Figure 37. Saving the Optimization Session
To configure modeling options specific to optimization, select Tools > Modeling Settings, press Ctrl+T, or
click on the configure modeling settings button (
). From there, go to Modeling Settings > Optimization
Settings (



Figure 38).



Select whether you want to optimize automobiles or light trucks, optimize using maximum net
benefits or maximum technologies, and the desired calibration settings. Click the next button to
continue.

Figure 38. Optimization Settings Window
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Configure the model for industry optimization by selecting the range of iterations to examine above and
beyond the manufacturer-optimized level, the increment between iterations, specify start year for
optimization (if selected) (



Figure 39). Click the next button to continue.

Figure 39. Industry Optimization Settings



Save the modified settings by clicking the apply button (
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Appendix G.3.2

Starting the Optimization Modeling

Step 2: Return to main control window and start the optimization modeling.


Select File > Start Modeling, press Ctrl+M, or click the start modeling button (

Figure 40. Starting the Optimization Modeling
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While the compliance modeling process is running, the model displays various progress
information in the session body, as well as the current iteration being examined at the bottom of
the window (Figure 41).

Figure 41. Optimization Session in Progress
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The optimization modeling process has concluded when “Modeling Completed!” appears at the
bottom of the main control window (Figure 42).

Figure 42. Optimization Session Completed
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Appendix G.3.3

Generating Reports For Optimization

Step 3: Generate the modeling reports.


To review the modeling reports selected for output, select Tools > Manage Output or press
Ctrl+U (Figure 43).

Figure 43. Manage Output Window for Selecting Output Reports



Select the desired reports, click save (

), then close (
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Generate the modeling reports by selecting File > Generate Reports or pressing Ctrl+R.

Figure 44. Generate Reports for Optimization



Wait for “Reporting Completed!” to appear at the bottom of the main control window.

Figure 45. Optimization Report Generation Complete
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Appendix G.3.4

Exiting the CAFE Modeling Application

Step 4: Exit the CAFE modeling application.


Select File > Exit, press Alt+F4, or click the close button (X) at the top-right corner of the main
control window.

A “Save Session?” dialog will appear. You may press Yes, to save the session, or No (recommended), to
discard saving the session (



Figure 46).

Figure 46. Save Optimization Session Before Closing
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Appendix G.3.5

Viewing Results

Step 5: View results by opening appropriate output files.
The model saves all log files to the output folder specified in Appendix B, Step 3, organized by the session
name. Similarly to the regular modeling runs, the model generates formatted Excel reports during
optimization, which are saved in the reports folder (

Figure 47). In the example session created in Step 1 (Appendix G.3.1), the optimization
reports will be located under C:\cafe\demo-run\demo-opt\reports.

Figure 47. View Optimization Results

All of the standard compliance and effects reports (not shown in the screenshot above) can
be generated when running the optimization modeling. Aside from those, the system
produces two additional optimization specific reports – one based on manufacturer
optimization and one based on industry optimization – which cover all iterations examined
by the model.


OptMfr_Report.xls: Manufacturer-level technology costs, benefits, fuel savings, and benefit-cost
ratios, for all iterations from manufacturer-specific optimization. This report also contains the
socially optimized level for each manufacturer by model year, and benefit-cost, marginal benefitcost, and net benefits charts.



OptInd_Report.xls: Manufacturer- and industry-level technology costs, fines, benefits, fuel
savings, and benefit-cost ratios, for all iterations from industry-specific optimization. This report
also provides the socially optimized functional form (aka, optimized shape) for the entire industry
by model year, and benefit-cost, marginal benefit:cost, net benefits, and optimized shape charts.
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Appendix H.1

Appendix F. Monte Carlo Analysis

Overview

Sensitivity analysis (i.e., Monte Carlo simulation) may be performed, such that all included
scenarios are examined under varying discount rates, technology costs and fuel consumption
effects, pretax fuel prices, rebound effect, and fuel-related externalities (monopsony, price shock,
military security, and carbon dioxide costs).

Appendix H.2

Appendix H.2.1

Operation

Step 1: Setup

Repeat the procedure for creating a new session as specified in Appendix B.


When selecting the Compliance Model you would like to use, be sure to select the “CAFE
Monte-Carlo Model” option.

Figure 48. Selecting Monte-Carlo Modeling Option
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Proceed as in Appendix B, Step 2 to the end of the wizard. On the Select Input Files screen,
remember to select the appropriate files configured for Monte-Carlo. Then, complete the New
Session Wizard by entering a session name and clicking the apply button (

).

Figure 49. Naming the Monte-Carlo Session



To configure modeling options specific to Monte-Carlo analysis, select Tools > Modeling
Settings, press Ctrl+T, or click on the configure modeling settings button (
to Modeling Settings > Monte-Carlo Settings.



). From there, go

Select whether to auto-generate new Monte-Carlo trial pairs or use a pre-existing trials file. If
auto-generating new trials, specify the number of trial pairs you wish to generate. Keep in mind
that each trial pair consists of two or more Monte-Carlo trials—one using the default discount
rate, and one or more using the alternative discount rates, which are specified in the Monte-Carlo
tab of the parameters file. Click the next button to continue.
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Figure 50. Monte-Carlo Settings Window



Save the modified settings by clicking the apply button (
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Appendix H.2.2

Step 2: Running

Return to main control window and start the Monte-Carlo modeling.


Select File > Start Modeling, press Ctrl+M, or click the start modeling button (

Figure 51. Start Monte-Carlo Modeling

106

).

DRAFT


While the compliance modeling process is running, the model displays various progress
information in the session body. During Monte-Carlo, the model also displays additional
information, toward the bottom of the window, which includes the current trial being examined,
the number of trials examined thus far, and the approximate time until completion.



Figure 52. Monte-Carlo Modeling Running

Once Monte-Carlo processing completes, the model will prompt to generate the Monte-Carlo log files (



Figure 53). The model does not support formatted Excel reports when operating in
Monte-Carlo mode. Therefore, it is recommended that the log files be generated at this
point.

Figure 53 Generate Monte-Carlo Log File Prompt
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The modeling process and generating of Monte-Carlo log files has concluded when
“Modeling Completed!” appears at the bottom of the main control window (Figure 54).

Figure 54 Modeling Completed in Monte-Carlo Mode
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Appendix H.2.3

Step 3: Exiting The CAFE Modelling Application



Select File > Exit, press Alt+F4, or click the close button (X) at the top-right corner of the main
control window.



A “Save Session?” dialog will appear. You may press Yes, to save the session, or No
(recommended), to discard saving the session.

Figure 55. Exiting Monte-Carlo Modeling
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Appendix H.2.4

Step 4: View Results

View results by opening appropriate log files.
The model saves all log files to the output folder specified in Step 1, organized by the
session name. The Monte-Carlo log files are saved in the MC-logs folder. In the example
session created in Step 1, the log files will be located under C:\cafe\demo-run\demo
mc\MC-logs.

Figure 56. Monte-Carlo Results Folder

As with regular modeling runs, the per-scenario logs are numbered in order of appearance,
starting at 0, with the first scenario (0) being the baseline, to which all others are
compared. The following files are generated at the end of the Monte-Carlo simulation.


MC_trials.csv: Contains pseudo-randomly generated Monte-Carlo trials used as input to
sensitivity analysis. The contents of the file are summarized in Table 37.



MC_tech_costs.csv: Specifies the sales-weighted average technology costs for each technology,
adjusted by the randomized cost scales from MC_trials.csv. The average costs for a technology
are computed across all vehicle technology classes that were used during modeling as follows:
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  SALESi  COSTi,t  
  SCALE , where SALESi represent the sales of
TECHCOSTt   i,MY
t


SALES

i
i,MY


vehicle i, COSTi,t is the base (unadjusted) cost of technology t as it applies to vehicle i, and
SCALEt is the randomized value specifying by how much to scale the technology cost of
technology t.


MC_tech_fcs.csv: Specifies the sales-weighted average technology fuel consumption
improvements for each technology, adjusted by the randomized fuel consumption scales from
MC_trials.csv. The average fuel consumption improvements for a technology are computed
across all vehicle technology classes that were used during modeling as follows:

 i,MY SALES i  FC i,t  
  SCALE , where SALESi represent the sales of
TECHFC t  
t


SALES
i,MY
i



vehicle i, FCi,t is the base (unadjusted) fuel consumption improvement of technology t as it
applies to vehicle i, and SCALEt is the randomized value specifying by how much to scale the
technology fuel consumption improvement of technology t.


MC_Sn*_data.csv: Includes the results of pseudo-randomly generated Monte-Carlo trials for all
scenarios. The log file for the results of the baseline scenario (0) provides the totals accrued
during that scenario. The log files for the results of non-baseline scenarios (1+) contain changes
compared to the baseline. The contents of the file are summarized in Table 38.
Table 37. MC_Trials.csv Contents

Column
Index
FuelPriceEstimates
DiscountRate
ReboundEffect
MonopsonyCost
PriceShockCost
MilitarySecurityCost
TotalEconomicCosts
CO2Costs
Cost(Technology)
FC(Technology)

Contents
unique index for the trial
randomized pretax fuel prices -- the probabilities are: 50% for
average fuel prices and 25% for low and high prices
value of the discount rate examined with each trial
randomized value of the rebound effect
randomized value of the monopsony cost
randomized value of the price shock cost
randomized value of the military security cost
randomized value of the total economic costs (not used)
randomized value of the carbon dioxide costs
randomized value specifying by how much to scale the technology
costs of each technology
randomized value specifying by how much to scale the technology
fuel consumption improvement of each technology

Table 38. MC_SN*_data.csv Contents

Column
Index
DiscountRate
AvePrice_MFR*(MY)
TechCost_MFR*(MY)
TechCost(MY)
SocialBenefits(MY)
FuelSavings(MY)
BCRatio(MY)

Contents
unique index for the trial
value of the discount rate examined with the current trial
average regulatory costs accumulated by the manufacturer, for
each model year
total technology costs accumulated by the manufacturer, for each
model year
total technology costs accumulated by the entire industry for each
model year
discounted social benefits accumulated by the entire industry for
each model year
fuel savings accumulated by the entire industry for each year
ratio of social benefits to total technology costs for each model
year
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